
Gel Doc™ XR+ and  
ChemiDoc™ XRS+ Systems 
with Image Lab™ Software 
Instruction Manual



Copyright ©2011 Bio-Rad Laboratories, Inc. Reproduction in any form, either 
print or electronic, is prohibited without written permission of Bio-Rad 
Laboratories, Inc.

CREDITS
1. Image Lab software is based in part on the work of the Qwt project 

(http://qwt.sf.net). 

2. Image Lab software is based in part on the work of the CImg project  
(http://cimg.sourceforge.net/).  
See license for details at  
www.cecill.info/licences/Licence_CeCILL-C_V1-en.html 

3. Image Lab software is based in part on the work of the Independent 
JPEG Group (www.ijg.org/) 

Alexa Fluor, Coomassie Fluor, Qdot, SYBR® and SYPRO are trademarks of 
Invitrogen Corporation. Coomassie is a trademark of BASF 
Aktiengesellschaft. Cy2 and Cy3 are trademarks of GE HealthCare. DyLight 
and Krypton are trademarks of Thermo Fisher Scientific Inc. Excel, 
PowerPoint, and Windows XP, and Windows 7 are trademarks of Microsoft 
Corporation. Macintosh, Mac OS, and Numbers are trademarks of Apple Inc. 
GelGreen and GelRed are trademarks of Biotium, Inc. Intel Core and Pentium 
are trademarks of Intel Corporation. Mitsubishi is a trademark of Mitsubishi 
Companies. PulseNet International is a trademark of Centers for Disease 
Control and Prevention. Slo-Blo is a trademark of Littelfuse.

CHEF (U.S. Patent Number 5,549,796, issued to Stanford University) is 
exclusively licensed to Bio-Rad Laboratories, Inc.

Precision Plus Protein standards are sold under license from Life Technologies 
Corporation, Carlsbad, CA, for use only by the buyer of the product. The 
buyer is not authorized to sell or resell this product or its components.

SYBR is a trademark of Molecular Probes, Inc. Bio-Rad Laboratories, Inc. is 
licensed by Molecular Probes, Inc. to sell reagents containing SYBR Green I 
for use in real-time PCR, for research purposes only.

Bio-Rad Laboratories, Inc. is licensed by Invitrogen Corporation to sell 
SYPRO products for research use only under U.S. Patent Number 5,616,502.

IL v.4.0



 Gel Doc XR+ and ChemiDoc XRS+ Systems
Safety and Regulatory 
Compliance

Important Safety Information
Please read these instructions before attempting to operate the  
Gel Doc™ XR+ or ChemiDoc™ XRS+ imaging systems.

This instrument is suitable for research use only. It must be used, therefore, 
only by specialized personnel who know the health risks associated with the 
reagents that are normally used with this instrument. 

Use of the Gel Doc XR+ and ChemiDoc XRS+ systems involves UV 
illumination. Proper precautions must be taken to avoid eye and skin exposure 
to the UV radiation. This instrument is meant for use only by trained personnel 
who know the health risks associated with UV radiation normally used with 
this instrument. The acrylic shield provides some UV protection. However, it 
does not guarantee complete protection, and it is designed to shield only the 
person working in front of the system.

WARNING! Use of the acrylic screen does not guarantee the user 
protection from UV radiation. The use of protective eyeglasses, 
mask, and/or gloves is strongly recommended.

Warranty
The Gel Doc XR+ and ChemiDoc XRS+ imaging systems are warranted 
against defects in materials and workmanship for 1 year. If any defect occurs 
in the instrument during this warranty period, Bio-Rad Laboratories, Inc. will 
repair or replace the defective parts at its discretion without charge. The 
following defects, however, are specifically excluded:

• Defects caused by improper operation
• Repair or modification done by anyone other than Bio-Rad 

Laboratories, Inc. or their authorized agent
• Use of spare parts supplied by anyone other than Bio-Rad 

Laboratories, Inc.
• Damage caused by accident or misuse
• Damage caused by disaster
• Corrosion caused by improper solvents or samples
iii
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General Precautions
• Please read the instruction manual carefully
• The instrument must be used only for the intended purpose of gel 

documentation in research laboratories
• The instrument must be connected to a grounded power source 

line and protected by a circuit breaker
• Switch off all the lights immediately after use
• Clean the transilluminator platen after use

Regulatory Notices
The Gel Doc XR+ and ChemiDoc XRS+ imaging systems are designed and 
certified to meet EN61010, the internationally accepted electrical safety 
standards, EMC regulations, and TUV requirements. Certified products are 
safe to use when operated in accordance with this system instruction manual. 
This instrument should not be modified or altered in any way. Modification or 
alteration of this instrument will:

• Void the manufacturer’s warranty
• Void the regulatory certifications
• Create a potential safety hazard 

WARNING! Bio-Rad Laboratories, Inc. is not responsible for any 
injury or damage caused by use of this instrument for purposes 
other than those for which it is intended or by modifications of the 
instrument not performed by Bio-Rad Laboratories, Inc., or an 
authorized agent.

Power Safety Information

VOLTAGE SETTING INFORMATION

The universal hood of the Gel Doc XR+ or ChemiDoc XRS+ imaging system 
has a power supply that automatically chooses the correct voltage for your 
country or region.

FUSES

The universal hood of the Gel Doc XR+ or ChemiDoc XRS+ imaging system 
has two user-serviceable fuses, F1 and F2, which are located on the bottom 
rear panel and are a part of the power entry module. Refer to the Maintenance 
chapter for fuse replacement instructions.
iv
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Gel Doc XR+ and ChemiDoc XRS+ Systems
1 Introduction
Gel Doc™ XR+ and ChemiDoc™ XRS+ gel documentation systems offer high 
performance and ease of use. They both contain a charge coupled device 
(CCD) camera to capture images in real time and allow you to accurately 
position your sample and generate optimized image data.

The Gel Doc XR+ and ChemiDoc XRS+ systems use the same lighttight 
enclosure (the universal hood), which contains built-in UV and white light 
illumination, but different CCD cameras. Both systems feature dynamic flat 
fielding technology for superior image uniformity and accurate quantitation.

Bio-Rad Image Lab™ software controls image capture and optimization for 
your selected applications, analyzes results, and produces reports based on 
your specified output, all in a single workflow.

Gel Doc XR+ Imaging System
Gel Doc XR+ imaging system is a high-resolution gel documentation system 
that allows fast, easy quantitation of gels and blots. Position your sample 
inside the imager and follow the onscreen steps to run a protocol with only 
one click. You can customize your applications within an existing protocol or 
create a new protocol using many options presented by the Image Lab 
software. 

Features include:
• Detection of dynamic ranges that cover > 3 orders of magnitude
• Dynamic flat fielding specific to fluorescent and colorimetric 

applications
1
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• Smart, application-based protocol setup using Image Lab 
software, which assists you by presenting appropriate filter and 
illumination sources for each application 

• Ability to upgrade to the ChemiDoc XRS+ system

ChemiDoc XRS+ Imaging System
In addition to the gel documentation applications of Gel Doc XR+, the 
ChemiDoc XRS+ imaging system offers sensitive chemiluminescent 
detection. The system includes a supersensitive 16-bit CCD camera that is 
deeply cooled for the long imaging times required for faint sample detection 
and for accurate quantification of image data.

Features include:
• Suitability for imaging applications that require excellent sensitivity 

(chemiluminescent western blots)
• Smart, application-based protocol setup using Image Lab 

software, which assists you by presenting appropriate filter and 
illumination sources for each application 

• Dynamic range > 4 orders of magnitude
• Flexibility to image chemiluminescent, fluorescent, and colorimetric 

samples with dynamic flat fielding specific to each application

System Components

CCD Camera and Lenses
Either the Gel Doc XR+ or the ChemiDoc XRS+ camera is placed on top of a 
lighttight enclosure (the universal hood) for capturing images. The camera 
comes with a motorized zoom lens (MZL) that allows remote adjustment of the 
lens control functions (zoom, focus, and iris). 

A patent-pending software algorithm controls the MZL, giving the user 
automatic image focus once an initial calibration is performed during system 
installation. See the Technical Specifications table, included in the chapter 
which discusses your camera, for complete specifications of each system.

A +1 diopter lens is factory installed to allow the entire sample stage to be 
visible. This lens should always remain on the MZL assembly.
2



System Components
Universal Hood
The universal hood is designed to capture fluorescent and chemiluminescent 
images without using a photographic darkroom. The enclosure has built-in 
white light epi-illumination and UV transillumination. For easy sample loading, 
the UV transilluminator is located in the drawer of the universal hood and can 
be accessed from the front of the enclosure. When not imaging, the lights in 
the darkroom enclosure turn off automatically.

The universal hood has touchpad buttons to perform various functions; 
however, Image Lab software controls all of these functions remotely, 
removing any requirement for manual control of the lens and lights.  
Running a protocol overrides any touchpad input.

Image Lab Software
Each system ships with a full version of Image Lab software. In addition to 
controlling the imager systems, image capture, and optimization, Image Lab 
software can be used to annotate and document images, analyze molecular 
weights (or base pairs, when imaging nucleic acid gels), and to determine 
accurate quantitation and purity of samples. 

You can print all or a subset of your data in a report. Alternatively, you can 
export your data to other software, such as Microsoft Office programs, for 
further analysis or presentation options. See Chapters 5 to 10 for detailed 
instructions on the software.

Emission Filters
The universal hood can hold two different emission filters for fluorescent 
applications. No filter is required to image chemiluminescent samples. 

A standard filter (catalog #170-8081) is used for colorimetric (white light) 
applications and is included in the installation kit. 
3
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Optional Accessories
Bio-Rad Laboratories, Inc. offers a selection of optional filters and illumination 
sources. See Appendix B for ordering information and a complete listing of 
accessory filters, UV light sources, optional parts, and replacement parts.

Printer 
For your convenience, Bio-Rad offers an optional USB printer for use with the 
Gel Doc XR+ and ChemiDoc XRS+ systems: the Mitsubishi P93DW thermal 
printer, (catalog #170-8089).

Conversion Screens 

WHITE LIGHT CONVERSION SCREEN

The white light conversion screen (catalog #170-8001) is a phosphor screen 
that produces white light transillumination when placed on top of the UV 
transilluminator. 

WHITE LIGHT TRANSILLUMINATOR 
An optional white light transilluminator (catalog #170-7950) may also be used 
with either system. The white light transilluminator plugs inside the universal 
hood and is controllable by the touchpad or the computer software. 

XCITABLUE™ CONVERSION SCREEN

The optional XcitaBlue screen kit (catalog #170-8182) is a UV to blue light 
conversion screen, which allows you to visualize DNA samples while 
protecting them from UV damage.

System Requirements
Image Lab software runs under Windows XP Professional, Windows 7, and 
Mac OS X. Images scanned at high resolution can be quite large. The amount 
of memory required for using the program is mainly determined by the size of 
the images you will scan and analyze. 

For this reason, we recommend that you archive images on a network file 
server or on removable storage media. Bio-Rad can also provide an 
appropriate computer to use with this system. Contact your local Bio-Rad 
representative for more details.
4



Computer Specifications
Computer Specifications

Specifications Minimum Recommended

Operating system Windows XP SP3 Windows XP SP3 Professional 

Windows 7, 32- and 64-bit Windows 7 Professional, 64-bit

Mac OS X 10.6 Mac OS X 10.6

Processor Pentium 4 or equivalent (Windows)  
at 2.0 GHz

Intel Core 2 Duo 2.0 GHz or higher

Hard disk space 20 GB > 100 GB

Memory (RAM) 1,024 MB > 1,024 MB 

Ports for connecting 
instrument

1 free USB 2.0 port 1 free USB 2.0 port

Other software 
(optional)

Microsoft Excel 2000 or later (Windows) Microsoft Excel 2000 or later 
(Windows)

Office 2008 or iWork software (Mac) Office 2008 or iWork software (Mac)
5
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Gel Doc XR+ and ChemiDoc XRS+ Systems
2 Gel Doc™ XR+ Imager
Refer to the Gel Doc XR+ Installation Guide (10016995) found in your  
Gel Doc XR+ Installation Kit (catalog # 170-8199) for instructions to install 
Image Lab software and to assemble and calibrate your system.

To recalibrate your system because you have acquired new accessories, refer 
to Chapter 4.

Gel Doc XR+ Imager Workflow
Following are the basic steps to acquiring, analyzing, and archiving an image 
using the Gel Doc XR+ system and Image Lab software:

1. Select an existing protocol or customize a new one.

2. Position the sample to be imaged.

3. Run a selected protocol.

4. View the displayed results.

5. Optimize the analysis.

6. Generate a report.

7. Save or export the results.
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Gel Doc XR+ Applications
The Gel Doc XR+ system is capable of running a wide variety of protocols. 
Those listed below are examples of the detection reagents that may be used 
to image your samples. Contact Bio-Rad technical support to determine 
whether your application can be imaged on this instrument. 

See Chapter 6, Acquiring Images, for complete instructions on designing 
protocols.

NUCLEIC ACID GELS
• Ethidium bromide
• SYBR® Green
• SYBR® Safe
• SYBR® Gold
• GelGreen
• GelRed
• Fast Blast™

PROTEIN GELS
• Coomassie Blue
• Copper stain
• Zinc stain
• Flamingo™ fluorescent gel stain
• Oriole™ fluorescent gel stain
• Silver stain
• Coomassie Fluor Orange
• SYPRO Ruby
• Krypton

BLOTS
• Colorimetric
• Qdot 525
• Qdot 565 
• Qdot 625
• Cy2
• Alexa Fluor 488
• DyLight 488
• Fluorescein
8



Gel Doc XR+ Technical Specifications
Gel Doc XR+ Technical Specifications 
Applications

Chemiluminescence No

Fluorescence* Yes

Colorimetry/densitometry Yes

Gel documentation Yes

Hardware Specifications

Maximum sample size, cm 28 x 36

Maximum image area, cm 25 x 26

Excitation source Trans-UV and Epi-White are standard (302 nm included, with 254 and 365 nm 
available as options). Optional Trans White, self-powered or conversion screen. 
Optional XcitaBlue™ UV/blue conversion screen.

Illumination control 3 modes
Trans-UV, Trans White, Epi-White

Detector CCD

Pixel size, H x V in microns 4.65 x 4.65

Cooling system Not applicable

Camera cooling temperature Not available

Filter holder 3 positions
(2 for emission filters, 1 for using no filter)

Emission filters 1 included (standard), 3 optional

Dynamic range >3.0 orders of magnitude

Pixel density (gray levels) 4,096

Dynamic flat fielding Application-specific, for all applications

Instrument size, cm 36 (L) x 60 (W) x 96 (H)

Instrument weight, kg 32

Operating Ranges

Operating voltage 110/115/230 V AC nominal

Operating temperature 10–28°C (21°C recommended)

Operating humidity <70% noncondensing

Automation Capabilities

Workflow automated selection Application driven, user selected or recalled by a protocol

Workflow automated execution Controlled by a protocol via application specific setup for image area, illumination 
source, filter, analysis, and reporting

Workflow reproducibility 100% repeatability via recallable protocols; from image capture to quantitative 
analysis and reports

Autofocus (patent pending) Pre-calibrated focus for any zoom setting 

Image flat fielding (patent pending) Dynamic; pre-calibrated and optimized per application

Autoexposure 2 user-defined modes (intense or faint bands)

*Using the optional XcitaBlue kit (catalog #170-8182) is highly recommended for SYBR® Safe DNA applications because 
the UV to blue conversion screen allows you to visualize DNA samples while protecting them from UV damage.
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3 ChemiDoc™ XRS+ 
Imager
Refer to the ChemiDoc XRS+ Installation Guide (10006999) found in your 
ChemiDoc Installation Kit (catalog # 170-8299) for instructions to install Image 
Lab™ software and to assemble and calibrate the ChemiDoc XRS+ system.

To recalibrate your system because you have acquired new accessories, refer 
to Chapter 4.

ChemiDoc XRS+ Imager Workflow
Following are the basic steps to acquiring, analyzing, and archiving an image 
using the ChemiDoc XRS+ system and Image Lab software:

1. Select an existing protocol or customize a new one.

2. Position the sample to be imaged.

3. Run a selected protocol.

4. View the displayed results.

5. Optimize the analysis.

6. Generate a report.

7. Save or export the results.
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When running chemiluminescent blots, you can use a signal accumulation 
mode, which takes a series of exposures within a period of time. This enables 
you to choose an image with optimal signal. Refer to Chapter 6 Acquiring 
Images for instructions.

ChemiDoc XRS+ Applications
The ChemiDoc XRS+ system is capable of running protocols to image all the 
detection reagents from the Gel Doc XR+ list, plus the others added to this 
list. Those listed are examples of the detection reagents that may be used to 
image your samples and not a complete list. Contact Bio-Rad technical 
support to determine whether your application can be imaged on this 
instrument. 

See Acquiring Images on page 29, for detailed instructions on designing 
protocols.

NUCLEIC ACID GELS

PROTEIN GELS

BLOTS

• Ethidium bromide • GelGreen

• SYBR® Green • GelRed

• SYBR® Safe • Fast Blast™ stain

• SYBR® Gold

• Coomassie Blue • SYPRO Ruby

• Copper stain • Silver stain

• Zinc stain • Coomassie Fluor Orange

• Flamingo™ fluorescent gel 
stain

• Krypton

• Oriole™ fluorescent gel 
stain

• Chemiluminescent • Qdot 625

• Colorimetric • Cy2

• Qdot 525 • Alexa Fluor 488

• Qdot 565 • DyLight 488

• Fluorescein
12



ChemiDoc XRS+ Technical Specifications
ChemiDoc XRS+ Technical Specifications 
Applications

Chemiluminescence Yes

Fluorescence* Yes

Colorimetry/densitometry Yes

Gel documentation Yes

Hardware Specifications

Maximum sample size, cm 28 x 36

Maximum image area, cm 25 x 26

Excitation source Trans-UV and Epi-White are standard (302 nm included, with 254 and 365 nm 
available as options). Optional Trans White, self-powered or conversion screen. 
Optional XcitaBlue™ UV/blue conversion screen.

Illumination control 5 modes (Trans-UV, Epi-White, and No Illumination for chemiluminescence  
are standard)  
Trans White and XcitaBlue conversion screens are optional.

Detector Supercooled CCD

Pixel size, H x V in microns 6.45 x 6.45

Cooling system Peltier cooled

Camera cooling temperature –30°C controlled

Filter selector 3 positions (2 for filters,1 without filter, for chemiluminescence)

Emission filters 1 included (standard), 3 optional

Dynamic range >4.0 orders of magnitude

Pixel density (gray levels) 65,535

Dynamic flat fielding Application-specific, for all applications

Instrument size, L x W x H in cm 36 x 60 x 96

Instrument weight, kg 32

Operating Ranges

Operating voltage 110/115/230 V AC nominal

Operating temperature 10–28°C (21°C recommended)

Operating humidity <70% noncondensing

Automation Capabilities

Workflow automated selection Application driven, user selected or recalled by a protocol

Workflow automated execution Controlled by a protocol via application specific setup for image area, illumination 
source, filter, analysis, and reporting

Workflow reproducibility 100% repeatability via recallable protocols; from image capture to quantitative 
analysis and reports

Autofocus (patent pending) Pre-calibrated focus for any zoom setting or sample height

Image flat fielding (patent pending) Dynamic; pre-calibrated and optimized per application

Autoexposure 2 user-defined modes (intense or faint bands)

*Using the optional XcitaBlue kit (catalog #170-8182) is highly recommended if performing SYBR® Safe DNA applications 
because the UV to blue conversion screen allows you to visualize DNA samples while protecting against UV damage.
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4 System Calibration
When your system is installed, system calibration is performed with a 
calibration wizard. See the Installation Guide (10016995 for the Gel Doc™ 
XR+ system and 10016999 for the ChemiDoc™ XRS+ system) in your 
installation kit for detailed instructions.

The instrument calibration wizard performs several procedures required to 
automate the system and prevent focus problems. Each of these calibrations 
affects your system as follows:

• Focus Calibration—this calibration allows automated focus 
settings at any zoom point, using a (patent pending) software 
algorithm. Therefore, your focus remains correct whether you view 
an entire sample or just an area of interest

• Focus Calibration with Height Offset—this calibration takes the 
tallest of the available conversion screens into account and 
extrapolates values for the others, so that focus remains optimal, 
whichever screen is used

• Dark Reference Image (Gel Doc XR+ system only)—this calibration 
determines and corrects any background signal present in your imager

• Bias Reference Image (ChemiDoc XRS+ system only)—this 
calibration provides a bias value correction 

• UV Flat Field Calibration—this calibration generates the flat field 
correction profiles needed for the UV light source. Because of this 
calibration, images have more accurate quantity reporting and 
backgrounds of even intensity

• Lens Flat Field Calibration—this calibration corrects for the 
intensity roll-off inherent in any lens
15
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• White Conversion Screen Calibration—this calibration generates 
a flat field correction profile needed for the white light conversion 
screen.

The Instrument Setup dialog box available from the Edit menu displays these 
calibration results for reference. The calibration wizard needs to be run only 
once, when your system is installed. The calibrations remain valid over the life 
of the instrument.

The calibration need not be changed unless you add equipment, such as a 
new light source.

When you add light sources or filters to a Gel Doc XR+ or ChemiDoc XRS+ 
system, recalibrate your system using the dialog box found at Edit > 
Instrument Setup. 

1. If you have a new illumination source, select the appropriate box in the 
Illumination Options field.

2. If you are adding new filters, use the drop-down list to match what is 
installed in your instrument.
16



3. The software prompts you to reset the calibrations needed for the new 
illumination sources. 

4. Click OK to exit the dialog box. Your settings remain until you make 
further changes.
17
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5 Image Lab™ Software 
Overview
Image Lab image acquisition and analysis software works with the Gel Doc™ 
XR+ and ChemiDoc™ XRS imaging systems to create a reproducible, 
automated, and time-saving workflow for imaging and analyzing gels. 

In Image Lab software, a protocol is any combination of imaging, analysis, 
and report settings that has been saved to run as a single workflow. 
Researchers can run one protocol repeatedly or easily design a wide range of 
protocols. 

With Image Lab software you can view analyzed data, edit the analysis, and 
produce customized reports that show precisely the settings applied in order 
to ensure repeatable results. 

Two types of files are generated by Image Lab software:
• Protocol files, which describe the parameters for imaging and 

analyzing your gel images. Protocol files are saved with a .ptl 
extension

• Image files, which contain the imaged gel, annotations, and 
analysis performed on the gel. Image files are saved with an .scn 
extension.

• An imaged gel, run according to a protocol file, generates an image 
file. 
19



Gel Doc XR+ and ChemiDoc XRS+ Systems | Image Lab™ Software Overview
Interface Overview
The following screen shows the Image Lab software main window. The 
accompanying paragraphs describe the main software elements.

Main Window 

Image Lab software displays a single main window. All image and protocol 
dialog boxes that present choices open in the workspace, which is the gray 
area of the main window. 

If many screens are open in the workspace, you can make one visible by 
clicking the title bar at the top of the selected screen. A list of open protocols 
and image files also appears in the Window menu; you can select one to bring 
it to the top.

You can view the complete analysis for an image or protocol at one time or 
compare image results by arranging the screens in the workspace.
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Interface Overview
Toolbar
Many Image Lab software tools can be selected by clicking toolbar icons. The 
Screenshot tool enables you to send a screen capture of your image to the 
clipboard or to save it as a file. You can view demonstrations of various 
functions by clicking Tutorials. The unlimited Undo and Redo buttons enable 
you to correct missteps easily. 

Additional tools for viewing protocols and results data presented in various 
forms are labeled below. These tools are described in Viewing Images on 
page 47.

Results Data
Results data associated with gel images can be viewed as an analysis table, a 
lane profile, a standard curve, or in a report. These views always display the 
analysis for the selected image. 

Buttons to toggle these views on and off are located in the main toolbar. All of 
them can be viewed at once. 

See Displaying Data on page 54 for details.

Display Toolbox
The display toolbox near the top of every image enables you to display  
images in the most useful ways. See Viewing Images on page 47 for a 
description of each option.

View results dataFile management
21
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Start Page
The Start Page guides you through creating, opening, and viewing protocols 
and images.
22



Interface Overview
Analysis Tool Box
The Auto Analysis button quickly analyzes images. 

The remaining tools customize the analyzed data.

Note: An image file must be selected (on a Windows computer, 
the title bar is dark blue) to make the analysis tools available. 

Image Tools enable you to flip, rotate, and crop images and to transform the 
image files. 

Lane and Band Tools control the detection function, enabling you to resize, 
adjust, and bend lanes and detect, adjust, add, or delete bands.

MW (Molecular Weight) (or base pairs, if using nucleic acid gels) Analysis 
Calculation enables you to choose standard samples, assign standard lanes, 
and choose a regression method.

Quantity Tools enable you to automatically quantitate bands, using either 
relative or absolute values.
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Annotation Tools are useful for drawing attention to any area of a gel.  

Volume Tools enable you to manually quantitate an object inside a boundary 
that you define. 

These tools are described on page 61.

Status Bar
The status bar in the lower right-hand corner of the main window shows the 
imager in use and the X and Y values for the cursor position on an image file.

The Int (intensity) values show a numerical value for the image intensity at the 
mouse position. The maximum data range using Gel Doc XR+ and ChemiDoc 
XRS+ Systems is 0–65,535, but the range  varies depending on the values 
contained within each image.

Menu Commands
The following section describes all menu commands in the File, Edit, View, 
Window, and Help menus. Many commands are also available on the toolbar 
or the Start Page.

FILE MENU COMMANDS

New Protocol enables you to create a new protocol that contains the 
necessary steps and choices. See Acquiring Images on page 29 for detailed 
instructions. Protocols can also be edited and stored for reuse. 

Open browses your file system to retrieve a previously saved protocol file or 
image file.

Recent Images gives you the choice of opening a recent image file.

Recent Protocols gives you the choice of opening a recent protocol.

Save enables you to save a protocol or image file once the protocol or image 
is named.
24



Interface Overview
Save As enables you to name and store a protocol or image. Protocols are 
stored with a .ptl file extension. Image files are stored with an .scn extension.

Close closes the active screen.

Close All closes all the screens.

Export enables you to export gel images or analysis tables with the following 
options:

• Export for Publication—exports a displayed image to a file. You 
can select from .bmp, .png, .jpg, and TIFF formats. The gel 
displays with any lanes, bands, and annotations that appear on the 
screen. See Exporting Gel Images for Publication on page 88 for 
more information

• Export for Analysis—creates a TIFF formatted file that retains all 
of the gel image data. Analysis data are not included. Use this 
option to analyze the image in other software such as Quantity 

One, FPQuest™, or InfoQuest™FP. See Exporting Gel Images for 
Analysis on page 89 for more information

• Export for PulseNet—reduces the image to an 8-bit TIFF image 
file. Resolution is limited and file size is restri cted to 300 dpi

• Lane and Band Table to Excel—if Excel (or Numbers, on a 
Macintosh) is installed on your computer, it will launch with your 
lane and band table displayed as a spreadsheet

• Lane and Band Table to File—exports as a CSV (comma-
separated values) file so your lane and band table can be opened in 
a database application

• Volume Table to Excel—if Excel (or Numbers on a Macintosh) is 
installed on your computer, it will launch with your volume table 
displayed as a spreadsheet

• Volume Table to File—exports as a CSV (comma-separated 
values) file so your volume table can be opened in a database 
application. See Exporting Results on page 87 for detailed 
information about exporting files

Image Info displays information about individual gel and blot images such as 
acquisition date, data range, and image capture details such as the exposure 
time and illumination source used, in three tabs (Image Details, Analysis 
Settings, and Notes). See Image Info on page 53 for more information.

Page Setup contains print controls such as orientation (landscape or portrait), 
margins, printer used, and paper size.

• Print displays a print preview of the gel and the header information, 
which includes the filename of the image, the user’s name, and 
date and time it was printed. The usual Windows Print screen is 
available as well; it enables you to select a printer and the number 
of copies
25
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• Exit closes Image Lab software (after prompting you to save 
changes to your protocols or images).

EDIT MENU COMMANDS

Undo undoes your last action.

Redo restores your last action, after an Undo.

Screenshot enables you to take a screen capture of the Lane Profile window, 
the Standard Curve window, or the default choice, Current Image view. This 
capture can include the name of the image. The image can be placed on the 
clipboard or saved in a file.

Default Imager enables you to switch between multiple imagers.

Instrument Setup enables you to review the instrument serial number and the 
calibration of the imaging system. If accessories are added, change the 
system calibration in the Instrument Setup dialog box.

Report Settings enable you to configure reports. This dialog box contains 
three tabs. All of the checkboxes are selected by default; clear the boxes to 
exclude information from  reports. Your selections apply to all reports, until 
you change them again.

• The General tab has options for excluding or reporting information 
about your gel image

• The Lane and Band Table tab enables you to choose whether to 
include all, or just some lanes, with appropriate identifiers. Lane 
profiles can also be included

• The Volume Table tab enables you to choose appropriate identifiers 
for the Volume Table and provides the option of excluding the table 
from  reports

Preferences displays two tabs.
• The Protocol tab shows presets for naming  image files. You can 

choose to include a designated Prefix, User Name, Date and/or 
Time in the name of your image files

• The Colors tab enables you to choose colors for the graphic 
elements in your gels, such as Lane Frame, Lane, Band, Band 
Attribute, and MW Legend. This functionality ensures that these 
elements are visible, regardless of the color of the gels
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Interface Overview
VIEW MENU COMMANDS

Image Overview opens a small window that shows the entire gel image with 
a red rectangle outlining the area visible in the larger main window. This is 
useful when you zoom into a small section of an image.

Image Transform opens a window showing a histogram, with which you can 
adjust the light and dark values of a gel image. This adjustment does not 
change your data; it changes only the way the data displays on your monitor.

Operations History opens a window showing the sequence of actions 
performed by both you and the software.

WINDOW MENU COMMANDS

The Window menu controls enable you to show and hide multiple open image 
files in your workspace. A list of all currently open images and protocols 
appears in this menu.

Tile aligns all open image files so all are visible at once.

Tile Horizontal places all open image files from top to bottom.

Tile Vertical places all open image files from left to right.

Cascade stacks all open image files and protocols with overlapping title bars, 
so each one can be easily chosen for view.

Imitate Zoom changes the zoom setting of all open images to the same zoom 
setting as the current image file.

Imitate Transform changes the brightness and contrast of all open images to 
the same transform settings as the current image file.

Next cycles through all open image files from oldest to newest.

Previous cycles through all open image files from newest to oldest.

HELP MENU COMMANDS

Image Lab Help displays the help system. 

User Guide displays the instruction manual in .pdf form.

About displays Image Lab software version information and release date.
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6 Acquiring Images
Image Lab software can run specific applications with repeatable workflows 
using custom protocols that have a wide variety of settings. These protocols 
can be retrieved, revised, and reused. 

In Image Lab software, a protocol is any combination of settings for imaging, 
analyzing, and reporting that has been saved to run as a single workflow.

A protocol allows the choice of one application for acquisition of a single 
image from a sample, with the exception of single accumulation mode for 
chemiluminescence. 

To access the Protocol Setup window:

You start a new protocol by choosing the New Protocol box on the Start Page 
or by choosing New Protocol from the toolbar or menu bar. 
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The Protocol Setup Window

This is the Protocol Setup window. The left pane displays headings and, 
under the headings, numbered protocol steps. You can enable or disable a 
step by selecting or clearing its checkbox. When you select a step, the right 
pane of the window displays the detailed settings for that step.

You can review protocol settings by selecting Protocol Summary, which lists 
all the settings for each step in the right pane of the Protocol Setup window.
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Creating a Protocol
• Select a step in the left pane and configure that step’s detailed 
settings in the right pane

• Select Protocol Summary in the left pane to view all your protocol 
settings in the right pane

Creating a Protocol
Setting up a protocol consists of three processes:

• Choosing acquisitions settings
• Analyzing the image
• Generating output

The three processes are listed in the left pane of the Protocol Setup window. 
Numbered steps in each process appear under these headings. To select an 
option under a protocol step, select the accompanying checkbox. Options for 
that step appear in the right pane of the window. To disable any step, clear its 
checkbox.

Acquisition Settings

STEP 1. GEL IMAGING
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APPLICATION OPTIONS
1. Choose an application from a menu that appears when you click the 

Select button. The applications appear in submenus under each 
application type. When you choose an application, any required filter or 
illumination source displays in the Protocol Setup window.

Note: For a list of applications with all required detection 
reagents, light sources, and any conversion screens or filters 
noted, see the Application Tables on page 45.

Custom Applications

Choose Custom Applications to run an existing application with a new 
name or an application unlike existing applications. Selecting Custom 
on the applications menu displays the Manage Custom Applications 
dialog box. If you have stored Custom Applications, they display here.

To create a new custom application:

1. Select New in the Manage Custom Applications dialog box.

The Create Custom Applications dialog box appears.
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Creating a Protocol
2. Choose a unique application name. 

3. Select a light source, filter, and image color on the drop-down lists. 

4. Select a binning setting. Choosing a higher binning setting combines 
pixels to increase the amount of signal without increasing noise. While a 
higher setting provides optimal sensitivity for low-light applications 
such as chemiluminescence, it also reduces image resolution. 

5. Click OK to create your custom application.

6.

7. Choose the Imaging Area from a list of Bio-Rad gels or enter image 
area dimensions. The red line represents the imaging area for the 
selected gel, and the gray rectangle represents the imager sample stage.

8. Choose Image Exposure Time—If you select the top radio button, 
Image Lab software acquires an image estimating an optimal exposure 
time. This option ensures the best use of the dynamic range.

• If you choose Intense Bands from the drop-down list, exposure is 
optimized for all bands 

• Choosing Faint Bands from the drop-down menu results in a longer 
exposure where faint bands are more visible, but more prominent 
bands may be overexposed

• Select the manual exposure radio button to override automated 
imaging. This may cause saturation (overexposure) of more 
prominent bands. Exposure time can range from 0.001 to 99 
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seconds using the Gel Doc™ XR+ system and from 0.001 to 7200 
seconds for the ChemiDoc™ XRS+ system.

After imaging a gel with automatic exposure optimization, the used 
exposure time displays in the protocol (see below), so that you can 
manually adjust the exposure time if needed.

Note: You can also view the exposure time of the image later, in 
the Image Info dialog box (refer to Image Info on page 53).

Signal Accumulation Mode — If you are running a chemiluminescent 
application on the Product name system, you can also use signal 
accumulation mode (SAM).

SAM is used to simplify capture of a good image of a chemiluminescent 
sample. This sample type often requires long integration times to obtain 
an image that represents the best range of signal.

Rather than manually acquiring a series of independent images with 
different imaging times, SAM presents a series of cumulative images 
with progressively greater signal in each image. SAM requires you to 
estimate the shortest and longest times expected to generate an image 
with the appropriate signal intensity. You then decide how many total 
images to acquire in this window of time.

For example, if the minimum time expected to image the sample is 1 
min and the maximum is 5 min, these values are entered (in seconds) in 
the setup window. By entering 5 in the Total number of images field, 3 
images will be acquired between the first and last images.

To use SAM, click Signal Accumulation Mode and select Setup to 
display the Signal Accumulation Setup dialog box.
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Creating a Protocol
In this example, the bar in the Signal Accumulation Setup dialog box 
shows that images will be acquired at one-minute intervals, starting at 1 
min and ending at 5 min. The second one-minute image is added to the 
first one-minute image, resultng in a two-minute total integration time 
image. The third one-minute image is added to the previous image, and 
so on, until the last image is presented.

Although SAM is useful for determining the optimum imaging time for a 
chemiluminescent sample, it does not result in data as accurate as a 
single image. Signal that is near the intensity of background noise 
becomes increasingly masked as the number of cumulative images 
grows. To identify extremely faint signals in an image, reacquire it as a 
single image, using the time the SAM tool found to be appropriate.

9. Set the Display Options 
 
Highlight saturated pixels—select the Highlight saturated pixels 
checkbox to see any saturated pixels in red. This will show how much 
of the gel image is saturated. This option can be changed later by 
selecting View > Image Transform. 
 
Image Color—select color choice to display the sample image. Viewing 
the image with a different color scheme can make it easier to see all of 
the elements. See Image Colors on page 51 to view the color choices 
dialog box.
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Analyze Image

STEP 2. DETECT LANES AND BANDS

To analyze the gel or blot, Image Lab software must detect lanes and 
bands on the image. Lanes are detected automatically, and then the 
background is automatically subtracted. Refer to Lane and Band Tools 
on page 66 for details. You customize band detection with the following 
options.

10. Select the Lane and Band checkbox in the left pane of the Protocol 
Setup window. The right pane displays lane and band detection 
options. 
 
Low Band Detection Sensitivity—this option sets detection at a low 
level for images with more prominent bands. Faint bands are not 
detected with this setting. 
 
High Band Detection Sensitivity—this option sets detection at a 
higher level for images that are more faint. Extraneous bands can be 
removed later, using the Band Tools in the Analysis Tool Box. See Lane 
and Band Tools on page 66. 
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Creating a Protocol
Custom—select a numeric value between 1–100 to choose the best 
detection sensitivity for your sample.

Note: When Low or High Band Detection Sensitivity is used, 
these numerical values are set: low sensitivity = 25; high 
sensitivity = 75.

STEP 3. ANALYZE MOLECULAR WEIGHT

11. To analyze molecular weight automatically, select Analyze Molecular 
Weight in the left pane of the Protocol Setup window. When this 
checkbox is selected, the software calculates the molecular weight for 
each band based on the specified standard.

12. To estimate the size of the molecules in the bands of your gel, enter the 
standards you are using, and specify the lane(s) in which the standards 
are placed. For nucleic acid samples, use this step to determine the 
size of the bands in base pairs.

STANDARDS

Determining molecular weight depends on the selection of the proper protein 
standards. Many protein standards are available from Bio-Rad. Many different 
DNA standards are also available. See Ordering Information on page 103 for 
all standards available from Bio-Rad and their catalog numbers.

The Change button opens the Manage Standards dialog box, in which you 
can add other third-party standard samples and edit the list.
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STANDARD LANES

13. Choose which lane contains your standards by typing lane numbers or 
the words First and Last in the Standard Lanes field. The format is xx, 
xx, xx, ... where xx is the lane number. For example, if you run an 18-
well gel and want your standards in lanes 1, 10 and 18, enter First, 10, 
and Last.

Note: Lane detection works best when standards are placed in 
the first and last lanes.
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REGRESSION METHODS

A regression method is used to calculate the molecular weight of the unknown 
bands. The software uses the relative front and molecular weight values of the 
standard bands to calculate the standard curve. This standard curve is then 
used to calculate the values of the unknown bands. The shape of the standard 
curve is based on the selected regression method. Choose one of four 
regression methods.

If you do not have enough data points for the selected method, the molecular 
weight of the unknown bands are not calculated.

14. Select the appropriate method for the gel type:
• Gradient gels: The Linear (semilog) regression method works well 

for these gels because the mobility of the bands is linear to the log 
of their molecular weight. As an alternative, the point-to-point 

(semilog) method can be used if the R2 value is not sufficient.
• Fixed percentage gels: These gels have a nonlinear relationship 

between the mobility and the molecular weight. For these gels, 
choose the logistic or cubic spline regression method.

You can check how well each regression method fits the data in the standard 
curve window (for more information, see Standard Curve on page 58). The 
linear (semilog) regression method provides a measurement that describes 

how well the standard curve fits the data R2 value. The closer the R2 value is 
to 1.0, the better the data fits the standard curve.

The molecular weight of each band is displayed in the analysis table in the 
Mol. Wt./Base Pair column. Refer to Copy Analysis Table to the Clipboard on 
page 90 for more information about molecular weight.

For information about the calculations behind the regression methods, see 
Regression Calculation Methods on page 111. 

Regression Method Minimum Number of Standard Bands

Linear (semilog) 2

Point-to-point (semilog) 2

Logistic 5

Cubic spline 5
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Output Settings
Image Lab software prints to the default printer unless you select otherwise.

You have three choices for specifying output:
• You can automatically print the image; this is useful for gel 

documentation, especially if a thermal printer is connected. See 
Mitsubishi P93/P95 Thermal Printer Settings on page 107 for 
instructions on setting up the Mitsubishi P93/P95 thermal printer

• You can automatically print the report, including all accompanying 
analysis information

Note: You cannot print a report on a thermal printer.
• You can display the image on your computer

STEP 4. SPECIFY OUTPUT

15. Select Specify Output in the left pane of the Protocol Setup window to 
display output options.

16. In the right pane, you can choose whether to automatically display or 
print an image or a report after a protocol runs. 
 
The report can be customized with the options in Edit > Report 
Settings. 
 
For information about reporting options, see Report on page 83.
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Choosing a Protocol
Review Protocol Settings
17. Click Protocol Summary in the left pane of any Protocol Setup window 

to see a quick review of all protocol settings.

Choosing a Protocol
To open a saved protocol:

• Click Open on the Start Page or click File > Open on the menu bar. 

You can also choose recently used protocols or image files from the lists on 
the Start Page. 
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Editing Protocols
Existing protocols can be changed and/or renamed using the many tools in 
Image Lab software.

Open any saved protocol. You are presented with the same set of menus and 
choices described in Creating a Protocol on page 31. 

Make and save your changes without renaming the protocol to replace an 
older one. Choose Save As and type a different name to make a second 
protocol.
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Positioning the Gel

To position a gel:

1. Click the yellow Position Gel button in the Protocol Setup window 
shown on page 42.

2. Place a gel on the imager stage and view the gel in Image Lab software.

3. Use the slider below the image to zoom the image into place. You can 
also move the gel manually until it is centered properly on the stage.

Note: The Bio-Rad gel alignment template kit supports four sizes 
of standard agarose gels and allows them to be centered quickly 
and easily. See Accessories on page 97 for more information.

Running a Protocol
To execute a protocol: 

• Click Run Protocol in the left pane

The software runs through the steps in imaging mode. A progress indicator 
tracks the process.
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If you enabled SAM in the protocol, the most recent image appears by default 
in the main window.

To end the protocol:

• Click Cancel Run 

To save and analyze an image at any time:

1. Right-click the thumbnail and select Save on the pop-up menu. 

2. Click Stop Acquire and Continue with Selected. 

This choice stops the acquisition and continues the protocol using the 
selected image. All other acquired images are discarded.
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Application Tables
The following tables contain all of the light sources, conversion screens, or 
filters you need for each application.

Table 1. Nucleic acid gels 

Detection Reagent
Preferred Light 
Source

Alternate 
Light Source

Preferred 
Filter

Alternate 
Filter 

Preferred 
Flat Field

Alternate 
Flat Field

Ethidium bromide UV None Standard 630/30 Orange Lens

SYBR® Green XcitaBlue™ UV 560/50 Standard Lens None

SYBR® Safe XcitaBlue UV 560/50 Standard Lens None

SYBR® Gold XcitaBlue UV 560/50 Standard Lens None

GelGreen XcitaBlue UV 560/50 Standard Orange Lens

GelRed UV XcitaBlue 630/30 Standard Lens None

Fast Blast™ stain White Trans None Standard None White Conv Lens

Table 2. Protein gels

Detection Reagent
Preferred Light 
Source

Alternative 
Light Source

Preferred 
Filter

Alternative 
Filter 

Preferred 
Flat Field

Alternate 
Flat Field

Coomassie Blue White Trans None Standard None White Conv Lens

Copper stain White Trans None Standard None White Conv Lens

Zinc stain White Trans None Standard None White Conv Lens

Flamingo™ stain UV None Standard Standard Orange Lens

Oriole™ stain UV None Standard None Orange Lens

Silver stain White Trans None Standard None White Conv Lens

Coomassie Fluor 
Orange

XcitaBlue UV 560/50 None Orange Lens

SYPRO Ruby UV None Standard None Orange Lens

Krypton XcitaBlue UV 560/50 Standard Orange Lens
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Table 3. Blots

Detection Reagent
Preferred 
Light Source

Alternative 
Light Source

Preferred 
Filter

Alternative 
Filter 

Preferred Flat 
Field

Alternate 
Flat Field

Colorimetric White Epi None Standard None Lens None

Qdot 525 UV None 520/30 Standard Lens None

Qdot 565 UV None 560/50 Standard Lens None

Qdot 625 UV None 630/30 Standard Lens None

Cy2 UV None 520/30 Standard Lens None

Alexa Fluor 488 UV UV 520/30 Standard Lens None

DyLight 488 UV UV 520/30 Standard Lens None

Fluorescein UV None 520/30 Standard Lens None
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7 Viewing Images
Once a gel has been imaged, the image appears in the workspace. Many 
controls are available to optimize viewing and to analyze the image.

Results Overview

The screen shows a gel image with band and lane detection as well as 
annotations. The labels show overlays that you can show or hide. 
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Refer to Display Gel Options on page 48 for more information.There are many 
ways to view the data associated with the results. You can view data as an 
analysis table, a lane profile, a standard curve, and as a report. 

Displaying Gel Images
Toolbar buttons appear above the displayed gel image. Each of these tools is 
described in the following sections.

Display Gel Options 

ANNOTATIONS

You can choose whether or not to show text and arrow annotations that have 
been drawn on the image.

LANES AND BANDS

You can turn on or off any image overlays, such as lane frames, lanes, bands, 
lane labels, and molecular weight legends.
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BAND ATTRIBUTES

You can show the following attributes for selected lanes or for all lanes.
• Band number
• Band label
• Molecular weight
• Relative front
• Volume
• Abs. Quant.
• Rel. Quant.
• Band %
• Lane %

VOLUMES

If you have drawn volume boundaries on the gel, you can display the volume 
boundaries and their volume labels.

Zoom Tools 
The zoom tools resize the gel image. Click the magnifying glass with the plus 
sign to make the image larger; the minus sign to make the image smaller.

You can also zoom with the right mouse button. Click and drag to select an 
area you want to magnify. Right-click again to return to the original view.

You can also resize the image with the scroll wheel on the mouse.

Fit in Window 
When you zoom in on an area of an image, clicking this button brings the 
entire image into view.
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Image Transform 

 

Use the Image Transform dialog box to adjust image brightness and contrast, 
optimizing the image display so faint detail can be seen. The minimum to 
maximum range varies, depending on the light and dark values present in the 
image. These adjustments do not change the data; they change only the way 
the data are displayed. The human eye cannot see as great a range as the 
image contains.

The frequency distribution histogram shows the total data range in the image 
and the amount of data at each point in the range.

Auto Scale determines an optimal setting for the image automatically. The 
lightest part of the image is set to the minimum intensity, and the darkest is 
set to the maximum.

• The High progress indicator determines which intensity value is 
shown at the maximum grayscale (or other color) in the gel image

• The Low progress indicator determines which intensity value is 
shown at the minimum grayscale (or other color) in the gel image

• The Gamma progress indicator changes the grayscale curve. A 
value of 1 is linear. A value < 1 redistributes a greater proportion of 
the grayscale to the first half of the intensity values. A value > 1 
redistributes a greater proportion of the grayscale to the second 
half of the intensity values

You can also type numerical values in the text boxes next to the progress 
indicators. Clicking anywhere on the progress indicator bars moves the 
progress indicator incrementally.

Options:
• Invert Image display—inverts dark bands on a light background to 

light bands on a dark background and vice versa
50



Displaying Gel Images
• Highlight saturated pixels—when this checkbox is selected, 
areas of the image with saturated signal intensity (above a 
measurable range) are highlighted in red

• Linear or Logarithmic histogram—this adjustment changes the 
y-axis on the histogram to display the number of pixels at each 
intensity value using either a linear or a logarithmic scale

Image Colors 

You can choose a colormap for an image results file. Viewing the image with a 
different color scheme can make it easier to see all of the elements in the 
image, but it does not change the data.

The first eight color choices imitate the colors of stained gels. The remaining 
choices supply enough color variation to highlight small differences in the 
image data. Available colors include:
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3-D Projection 

Clicking 3-D transforms the gel image into a solid 3-dimensional model 
spinning in space with x, y, and z dimensions. Accentuate or diminish the 
relative heights of data points by pulling the slider at the bottom of the window 
to the right or left.

To view the intensity of various bands:
1. Select 3-D in the display toolbox above the image.

2. Click and drag the model to rotate it into your preferred view.

3. Bring the window into focus by clicking the image.

4. Press C to display a green cone, which can be dragged around to 
evaluate the intensity of various bands.

• Gray • Flamingo

• EtBr (Ethidium bromide) • Silver

• Coomassie • False Color

• Stain Free • Spectrum

• SYBR Green • Gold-Silver

• SYPRO Ruby • Pseudo
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Image Info
The Image Info dialog box provides information about an active image. Click 
Image Info in the display toolbox to display three tabs of information about the 
image.

IMAGE DETAILS

Acquisition and image information appear in this tab.

ANALYSIS SETTINGS

The settings that were used when the gel was analyzed are displayed here, for 
example, Band Detection and Molecular Weight Analysis, if they were 
performed.

NOTES

You can add notes, make custom labels for each of the lanes, point out the 
types of samples used, and add any other information about the results.
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Displaying Data
The results from analyzed data associated with the gel images can be 
visualized using an analysis table, a lane profile, a standard curve, or a report.

Buttons to toggle these views on and off are located in the main toolbar. All of 
the views can be seen at one time.

Analysis Table 
Numerical data associated with an analysis can be viewed in the analysis 
table. Data from the Lane and Band analysis can be viewed in the Lane and 
Band tab. If volume analysis was performed, this data can be viewed in the 
Volume Table tab.

Clicking Analysis Table opens a tabular display of the data extracted from the 
results. The buttons above the table offer several ways of displaying and 
exporting analysis table data.

SET WINDOW SIZE

To change the size of your Analysis Table window, move to the top of the 
window until the cursor changes into a double-headed arrow. Left-click and 
drag the edge of the window until you can see all of the data.

Note: Resizing the Analysis Table window is restricted when a 
Protocol window is open.

DISPLAY DATA OPTIONS 
This dialog box displays three tabs: Measurements, Display, and Export.

Measurements—choose the measurements you want displayed by clicking 
the arrow buttons to move them from the Displayed to the Not Displayed field.
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Displaying Data
Default display settings—move selected lane to top is on or off, depending 
on whether the checkbox is selected.

Per Measurement Precision—you can set the precision (decimal places) for 
the measurements in both the Lane and Band table and the Volume table.

Example Precision—this field shows how your measurement will display, 
with the number of decimal places you choose in Per Measurement Precision.

Export formatting—this field offers two checkboxes to include lane headers 
(Lane and Band table tab only) and/or column headers in the exported file.

Export delimiter—this field offers three delimiter options for the exported file. 
• CSV (comma-separated values)
• Tab delimited
• Other user-defined delimiter 

CHANGE ANALYSIS TABLE ORIENTATION 
This button toggles between two table orientations.

Horizontal—displays the lanes/volumes beside each other, so you can scroll 
through the table from left to right.

Vertical—displays the lanes/volumes on top of each other, so you can scroll 
through the table from top to bottom.

Copy Analysis Table to the Clipboard  —click this button to copy the 
analysis table to the clipboard so you can paste the analysis table into word 
processing or presentation applications. It is best to use the vertical table 
orientation when copying to an 8-1/2 x 11-inch page, to allow the columns 
enough room to display.

Export Analysis Table to a File  —when exported as a CSV (comma-
separated values) file, the data file can be opened in a database application.

Export Analysis Table to a Spreadsheet  —you can use Excel’s sorting 
and formula functions to manipulate the data. If you have Excel (or Numbers, 
on a Macintosh) installed on your computer, it opens with your spreadsheet 
displayed.

Lane and Band Definitions
Band Number—each band in a lane has a unique number, sorted from top to 
bottom.

Band Label—you can assign a custom label to each band by clicking the 
Band Label field of the Lane and Band table. 
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Molecular Weight—the molecular weight of the band is calculated based on 
the user-defined standard and regression method. Italic values indicate 
extrapolated values. When using nucleic acid gels, the size of the band is 
displayed in base pairs.

Relative Front—values between 0–1 indicate the relative movement of the 
band from top to bottom.

Abs. Quant.—absolute quantification of the band.

Rel. Quant.—relative quantification of the band compared to the reference 
band.

Band %—percentage of the band volume compared to all band volumes in 
the lane.

Lane %—percentage of the band’s volume compared to the entire volume of 
the lane.

Volume Definitions
Volume Number—a unique number is assigned to each volume.

Volume Label—software-generated labels for different types of volumes (U—
Unknown, B—Background, S—Standard) can be changed in Volume 
Properties.

Volume—the sum of all the intensities within the band boundaries.

Adjusted Volume—the background-adjusted volume.

Mean Background—the mean value of the background. 

Absolute Quantity Volume—the quantity of the volume based on the 
standard volumes and the regression method.

Relative Quantity Volume—the ratio of the adjusted volume and the adjusted 
volume of the reference volume.

# Pixels—number of pixels inside the volume boundary.

Minimum Value—intensity of the pixel with the minimum intensity inside the 
volume.

Maximum Value—intensity of the pixel with the maximum intensity inside the 
volume.

Mean Value—mean value of all pixels inside the volume boundary.

Standard Deviation—standard deviation of all pixels inside the volume 
boundary.

Area—area of the volume in mm2.
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Lane Profile 

The Lane Profile option shows a cross-section of the selected lane, rotated 90 
degrees. You can select other lanes by clicking them while the Lane Profile 
window is open.

When the Include Background checkbox is selected, the Lane Profile window 
shows the subtracted background under the blue line. The area used for band 
quantification appears in green under the red line.

You can see the current Rf (relative front) value and the intensity at the cursor 
in the lower-right corner of the Lane Profile screen.

You can change how the bands are labeled by choosing from the options in 
the drop-down list. By default, the bands are labeled with the band number.

SCALE TO FIT GRAPH

You can choose the highest point of the display to define the range of the 
graph. This provides the best view of the lane profile.

You may want to clear the Scale to Fit Graph checkbox to display the entire 
range of possible intensity values in the graph. Doing so allows valid 
comparisons between different lanes.

INCLUDE BACKGROUND

When you clear the Include Background checkbox, the area of the lane profile 
that represents the background of the image does not display.

Background
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IDENTIFY BANDS BY

You can display call outs on the Lane Profile, which indicate these attributes:
• Band Number
• Band Label
• Molecular Weight
• Relative Front
• Volume
• Abs. Quant.
• Rel. Quant.
• Band %
• Lane %

Standard Curve 

The Standard Curve dialog box displays the best curve fit for the defined 
standards and the bands relative to this curve for the lane selected in the 
image. The tabs display the standard curves for three different analyses.
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Displaying Data
Standards appear in green; unknown bands appear in red. You can change 
the molecular weight display on the y-axis between linear and log scale by 
clicking the Log y-axis box at the upper left. The regression method you 
chose in Molecular Weight Analysis Tools appears, as well as the formula (if 
applicable) and the R2 value of the regression method.

Tabs in this window display the Mol. Weight Standard Curve, the Abs. 
Quantity Standard Curve, or a Volume Standard Curve.

Report 
See Generating Reports on page 83 for information about reports.
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8 Analyzing Images
Analysis Tool Box tools are enabled once an image file is opened and in focus. 
An active or “in focus” window has a darker blue menu bar on a Windows PC. 
On a Macintosh, the window control icons display more brightly when a 
window is active. This distinction helps you to identify the active window 
among many open image files in your workspace.

Auto Analysis Settings
Clicking Auto Analysis in the Analysis Tool Box enables you to do the 
following:

• Analyze images that were obtained with protocols that did not 
include steps for detection and analysis

• Change your analysis parameters to reanalyze your images 

Note: If you change any settings for an analyzed gel, the initial 
analysis is overwritten. To preserve both analyses, save the 
image file with a different name.
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DETECTION SETTINGS

Band detection options are as follows:

Low Band Detection Sensitivity—this sets detection at a low level, for 
images with prominent bands. Faint bands are not detected with this setting.

High Band Detection Sensitivity—this sets detection at a higher level for 
images that are faint. Extraneous bands can be removed using the Band Tools 
in the Analysis Tool Box. See Lane and Band Tools on page 66.

Custom—you can set a numerical value between 1 and 100 to select the best 
detection sensitivity for your sample.

When Low or High Band Detection Sensitivity is used, the following numerical 
values are set: low sensitivity = 25; high sensitivity = 75.
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MOLECULAR WEIGHT ANALYSIS SETTINGS

Molecular Weight Standard—choose any of the many Bio-Rad standards or 
other standards you have placed in your standards list. For more information, 
refer to Standards on page 37. 

Standard Lanes—choose or change the lanes in which the standards are 
placed. 

Regression Method—four regression methods are available. For more 
information, see Regression Methods on page 39.

Analysis Toolbox Tools
All Analysis Toolbox tools customize the analyzed data in image files. These 
tools are available only when an image file is open. Click a specific image to 
select among many windows that may be open in your workspace. 

Note: Some tools delete the existing analysis. 

To access a tool:
• Click any of the tool box buttons 

To return to the Analysis Tool Box menu:
• Click the green up-arrow to the right of the tool name
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Image Tools 
To show the image tools menu, click Image Tools.

 

FLIP 
You can flip gel image horizontally or vertically.

ROTATE
You can rotate gel image 90° to the left or right by clicking the Rotate buttons. 

To correct a slanted gel:
1. Click Custom. 

2. Rotate the red arrows that appear over the gel to any degree between 
0–360° by dragging them.

3. Right-click the gel image and choose Rotate to set the gel in the new 
position. You will be prompted to Cancel or Continue, in case you want 
to reset the rotation.

CROP
You can save crop settings and use them to crop other images. This feature is 
useful when you want to crop the same area in several images. 

To crop a gel image: 
1. Click Crop. A red box outlines the image area.

2. Drag the red box to surround the image area you want to keep. 

3. (Optional) Right-click the image to open the Crop menu and click Save 
Crop Settings. 

Click to return
to the
Analysis Tool Box
menu
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4. (Optional) Type a name for the crop settings in the dialog box that 
appears and click OK.

5. Right-click and select Crop or Cancel. Selecting Crop crops the image 
to the area inside the red box.

To crop an image using saved crop settings:
1. Click Crop. A red box outlines the image area.

2. Right-click the image to open the Crop menu and click Load Crop 
Settings. 

3. Select the saved crop settings in the dialog box that appears and click 
Load. The red box resizes and the crop specifications appear on the 
image.

4. Right-click and select Crop. The image is cropped to the area specified 
in the crop settings you selected.

To delete crop settings:
1. With an image open, click Crop. 

2. Right-click the image inside the red box to open the Crop menu and 
click Delete Crop Settings. 

3. Select the crop settings in the dialog box that appears and click Delete.

INVERT DATA

Invert Data is used for negative stains and zymograms. Intensity values of 
bands must be greater than background to perform analysis on the gel. View 
the gel as a 3-D projection to determine if the data must be inverted.

MERGE
Use this button to merge a chemiluminescent blot image with a colorimetric 
image of the same blot. If you have used colorimetric prestained standards for 
a chemiluminescent blot, you can acquire an epi-white light image of the blot 
to show the standards and a chemiluminescent image to show immuno 
detection. These two images can then be merged into a combined image with 
both signals. 

Note: Merging images can have an adverse effect on 
quantitation. If accurate quantitation is required, perform analysis 
on the original, separate images. Only images of the same size 
can be merged.
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 Lane and Band Tools
Click Lane and Band Tools to select a tab—one to use the lane tools and one 
for band tools.

LANE TAB

You can choose how lanes are detected by selecting Automatic or Manual 
Lane Finder.

• Click Automatic if the gel image is fairly typical
• Click Manual to detect a specific number of lanes or if automatic 

lane detection did not find all the lanes. You can then drag the 
handles on the corners of the red square to resize the lane frame 
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ALL LANES

Resize—you can resize all lanes by dragging the handles on the corners of 
the red square to fit the gel image.

Adjust—if the gel image is irregular, you can adjust the orientation of all lanes 
by dragging a single corner of the lane frame. The Adjust tool does not resize 
the lane width.

You can also add more anchor points on the top or bottom borders of the 
rectangle by clicking the lane frame. Remove any unneeded anchor point by 
right-clicking it. By dragging these anchor points, you can adjust for so-called 
smiling gels.

Delete—you can delete all lanes.

SINGLE LANE

Add—you can add a single lane to a gel image. First click Add, and then click 
within the lane frame where you want to place the new lane. The lanes are 
renumbered.

Note: To add a lane outside the frame, add a lane inside the 
frame and click Move to expand the lane outside the frame’s 
boundaries.

Delete—you can delete a single lane. First click Delete, and then click either 
the lane or its lane number. The lanes are renumbered.

Bend—you can bend a single lane to better fit the gel image. First click the 
Bend button and then drag one of the square anchors to fit the image.

You can add more anchor points within the lane by left-clicking it. Drag these 
anchor points to adjust the lane to fit the gel image. Remove anchor points by 
right-clicking them.

Move—you can move a single lane to a new position on a gel image. First 
click Move, and then click the lane you want to move. Drag it to a new 
location. The lanes are renumbered according to their new position.

Width—you can change the width of a single lane.

LANE BACKGROUND SUBTRACTION

Perform lane-based background subtraction by selecting Enable Subtraction 
in the Background Subtraction field. Use the Lane Profile view to see the 
subtracted lane background.

Rolling Disk—you can specify the size of a hypothetical rolling disk (between 
1–99 mm) that removes background levels along the length of the lane. The 
size of the disk determines how much background is subtracted. 
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A large disk follows the profile trace less closely, touching fewer points along 
the trace and removing less background. A smaller disk more closely follows 
the profile trace, removing more background.

A disk radius that is too large will result in poor background removal. A disk 
radius that is too small may subtract actual data. For most samples, a size of 
<10 mm is usually appropriate. You can perform this task several times until 
you are satisfied with the amount of background removed. Use the Lane 
Profile tool to evaluate the appropriate disc size for background subtraction. 
See Lane Background Subtraction on page 67.

Apply to selected Lane—When you select this box, the level of background 
subtraction specified with the previously described buttons is applied only to 
the selected lane. This option enables you to set different background 
subtraction levels for each lane.

BANDS TAB

This tab enables you to detect bands or reset band detection settings. Click a 
button in the menu, and then click a lane in the image.
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Detect Bands—this option opens a dialog box in which you can select band 
detection sensitivity and the lanes to which it applies.

Add—use this option to add faint bands. First click Add, and then add a new 
band by clicking anywhere inside the lane. 

Note: You can darken your entire image to view faint bands more 
easily using the Gamma slider in the Image Transform dialog box. 
For instructions, see Image Transform on page 50.

Delete — You can delete bands that are not relevant to your analysis. First 
click Delete, and then click any bands you want to remove.

Adjust—you can adjust the height of a band. First click Adjust. Two boundary 
lines appear around each band. Move over a boundary line until you see a 
double-headed arrow. Move the boundary line up or down; the center 
recalculates; the band appears there.

Note: You can also adjust the band boundaries in the Lane Profile 
view.
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Molecular Weight Analysis Tools
Molecular Weight Analysis Tools enable you to determine molecular weight (or 
base pairs, if using nucleic acid gels) by comparing a test sample with known 
standards.

You can view each band’s molecular weight in the molecular weight column of 
the Lane and Band tab in the Analysis Table view or in the gel image by 
selecting Mol Wt. from the Band Attributes section of the Display Gel Options 
window:

MOLECULAR WEIGHT STANDARD

You can change the standards that determine the molecular weight of test 
samples. 

Click Change to access the Manage Standards dialog box, where you can 
choose another standard or add third-party standards. 
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STANDARD LANES

Standard samples are placed in the first and last lanes by default. You can 
specify other standard lanes by selecting the box below each lane or by 
entering the standard lane numbers separated by commas. Standard lanes 
are labeled Std below the lane. 

REGRESSION METHODS

There are four regression methods. See Regression Methods on page 39.

Quantity Tools 
You can quantitate bands in test samples automatically using either the 
Relative or Absolute tabs under Quantity Tools.

RELATIVE QUANTITY TAB

To compare the relative quantities of bands, first select Quantity Tools 
(Relative tab) as shown.
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To select a reference band from an image and quantitate all other bands 
relative to the reference band:

1. Click the Select button.

2. Click any band you want to use as a reference. A small R for Reference 
appears near the band you selected (see the red circle in the upper left). 

To review the relative band quantities:
• Go to the Rel. Quant. column of the Analysis table (Lane and Band 

tab). The relative quantity is the ratio of the band volume divided by 
the reference band volume

All other bands now display numerical values that are relative to the reference 
band. Values above 1.00 indicate that the band quantity is greater than the 
reference band. Values below 1.00 indicate the band quantity is less than that 
of the reference band.
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ABSOLUTE QUANTITY TAB

Absolute quantification is used to quantify bands based on known standard 
bands using a calibration curve. To determine the absolute quantities of 
bands, first select Quantity Tools (Absolute tab) as shown:

To calculate the absolute quantities of the bands:
1. Click Select.

2. Select at least two standard (known) bands and assign quantity values. 
The values display in the Standard bands table. The greater the number 
of known bands and the wider the range of their values, the more 
accurate the absolute quantity calculation of the unknown bands.

Note: Any standard bands selections can be deleted. To do so, 
select the entry in the Standard Bands field by clicking it and then 
clicking Delete.
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3. Select a unit of measure from the ten choices listed in the Units drop-
down list. 

4. Select a regression method from the three listed in the drop-down list. 

Keep the following guidelines in mind while making your choice.

Linear—this method generates a straight line that is the best fit of the 
values you provided and is preferred in most cases. 

Point-to-point—this method generates a curve in which each data 
point is connected directly to the next, regardless of the shape of the 
resulting curve.

Cubic spline—this method generates a smooth curve that connects 
each data point. At least four standard points are required to use this 
method of least-squares polynomial fits.

5. Click Standard Curve in the toolbar, select the Absolute Quantity 
Standard Curve tab, and a calibration curve displays. All standards are 

Regression Method
Minimum Number of 

Standard Bands

Minimum Number with 
Force Through Origin 

Option

Linear 2 1

Point-to-point 2 1

Cubic spline 5 4
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represented by green triangles. Unknown values are represented by red 
triangles.

Note: Selecting the Force Through Origin checkbox always starts 
the standard curve graph at 0,0, regardless of the best curve fit.

Note: Clicking the Standard Curve table generates a crosshair 
tool that displays the numerical values associated with the 
placement of the cursor in the graph.
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Annotation Tools
You can annotate results with text and arrows to draw attention to areas of 
interest.

ADD ANNOTATIONS

Text—you can add text annotations to gel images to draw attention to 
important details. First click Text, and then click an area you want to 
emphasize. A text box appears with a dotted-line border. Type your comment 
in the text box. Drag the box to change its position.

Note: While editing text, press SHIFT+ENTER to add text. This 
adds a new line in the annotation.

Arrow—to add an arrow, first click Arrow. Click the area where you want the 
arrow to start and then drag to stretch the arrow point to the location you want 
to emphasize. To move the arrow, click the middle and drag it. To change 
where the arrow points, click either end of the arrow. Square boxes appear; 
drag a box to change the length or orientation of the arrow.
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ALIGNMENT

Alignment Icons—these buttons enable you to align multiple annotations, 
such as lane numbers, which you have manually added.

To select annotations—you can select several annotations by holding down 
the CTRL key (Command key on the Mac) and clicking each one or by 
dragging a selection box around them.

To copy annotations—you can copy annotations within or between images. 
First select the annotation you want to copy. Then press CTRL+C to copy and 
CTRL+V to paste the annotations.

TEXT PROPERTIES

You can change the size and type font of your text annotations. To select 
multiple items for change, hold down the CTRL key (Command key on the 
Mac) and click each item.

Font—first click the text box you want to change. Then open the drop-down 
Font list to show all fonts installed on your system. Click one of the font 
names to change the style of the text annotation.

Size—first click the text box you want to resize. Click the up and down Size 
arrows to increase or decrease the size of the text. You can set the font size 
between 6 and 72 points using the drop-down list. 

COLOR

You can change the color of text annotations to make them visible with any 
color scheme and emphasize them further by adding a color to the 
annotation’s background, which is invisible by default. 

To change the color of multiple items, hold down the CTRL key and click each 
item.

Foreground—click a text annotation or arrow. This activates the Foreground 
field, so you can use the drop-down list to choose a different color.

Background—click a text annotation. This also activates the Background 
field, so you can use the drop-down list to choose a background color.

ROTATE

You can rotate text annotations 90° to the left or right by clicking the Rotate 
buttons.
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Volume Tools
Volume tools enable you to manually quantitate features on a sample image 
when automated lane and band analysis is not appropriate or possible, such 
as in dot blots. 

You can use volume tools to quantitate the signal intensity of bands, spots, 
arrays, and other image data. You define an area of interest by surrounding it 
with a shape. You can choose a rectangle, circle, freehand shape, or lane by 
clicking the buttons under the Volumes field. 
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A default label appears within the shape drawn. The volume label can be one 
of three types—U for Unknown, Std for Standard, or B for Background—along 
with a number that is assigned sequentially.

Each new volume you create initially has a red border, which indicates that the 
volume is selected. When you click elsewhere on the image, the border 
changes to blue, indicating that the volume is no longer selected.

Note: Double-click a volume area to change its properties. 

To review data for the volumes:
• Open the analysis table and select the Volume tab. Volumes are 

listed based on their number and/or the associated information per 
volume. See Volume Definitions on page 56.

VOLUME TYPES

You can define the volume type (unknown, standard, or background), the 
quantity of standard volumes, or enter a custom name to replace the default 
label.

Unknown volumes are volumes you want to quantify. 
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Standard volumes are used for absolute quantities. See Absolute Volume 
Quantity on page 81. 

Background volumes are used to remove the background from the 
calculation. The result of volume background subtraction appears in the 
Adjusted Volume column of the analysis table (Volume tab).

VOLUME BACKGROUND SUBTRACTION

When you draw a volume, some non-data background pixels may be included 
inside the volume. These background pixels usually have an intensity value 
that you do not want to include in your volume quantitation. There are two 
ways of calculating this background intensity for your volumes: local and 
global.

Local—local background subtraction calculates a separate background 
intensity for each unknown and standard volume you create. For each volume, 
the intensities of the pixels in a 1-pixel border around the volume are added 
together and divided by the total number of border pixels. This gives an 
average intensity for the background around each, which is then subtracted 
from the intensity of each pixel inside the volume. If the background value is 
greater than the pixel value inside the volume, the background-adjusted 
quantity of the volume may be < 0. In this case, redraw the border for this 
volume.

Global—global background subtraction calculates a single background 
intensity for the entire gel. This average background intensity is then 
subtracted from all the volumes in the gel. The average intensity of the pixels 
in the background volume is calculated and subtracted from each pixel in all 
standard and unknown volumes. Therefore, it is not necessary for the 
background volume area to be the same size as your unknown.

To calculate global background subtraction:
1. Create a volume using one of the volume tools in a representative 

background region of your image (that is, a non-data region similar to 
the background surrounding your data).

2. Double-click the volume. This opens the Volume Properties dialog box.
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3. Select the Background option button. 

Notes:
• If you select Global in the Volume toolbox but do not define a 

background volume as described, no background subtraction is 
performed 

• If you create more than one background volume, all the pixels in 
those background volumes are used to calculate the average 
background. Your background volume(s) will have default names 
B1, B2, and so on based on the sequence in which they were 
created

• If the region you defined as background has a higher average 
intensity value than your data object, you obtain a negative value 
for your adjusted volume in the analysis table. If this happens, 
select a new background region with less intensity than your data 
object

RELATIVE VOLUME QUANTITY

You can choose any one volume as a Reference Volume by selecting the 
Reference Volume checkbox in the Volume Properties dialog box. The 
Reference Volume is indicated by an asterisk on the volume label, for 
example, U1*.

Relative quantities are displayed in the Relative Quantity column in the 
analysis table (Volume tab). The relative quantity is the ratio of the 
background-adjusted volume divided by the background-adjusted reference 
volume.

All other volumes now display numerical values relative to your reference 
volume. Values above 1.0 indicate that the volume is greater than the 
reference volume. Values below 1.0 indicate the volume is less than the 
reference volume.

ABSOLUTE VOLUME QUANTITY 
If you have drawn your volume around an object of known quantity, you can 
use it to calculate the quantity of your unknown volumes. The quantities of 
your unknown volumes are calculated based on the standard volumes and the 
selected regression method.

To classify a particular volume as a standard:
1. Double-click the volume. This opens the Volume Properties dialog box.

2. Select the Standard option button and enter the quantity in the Quantity 
box. 

3. Click OK to close the dialog box. 
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Standard volumes will have the default names S1, S2, and so on, based on 
the sequence of their creation. 

To review the regression curve:
• Open the Standard Curve window and select the Volume Standard 

Curve tab

REGRESSION METHODS

Three regression methods are available to generate the volume quantitation 
curve used for absolute quantity: linear, point-to-point, and cubic spline. To 
display the standard curve, click the standard curve button in the toolbar and 
select the Volume Standard Curve tab in the Standard Curve dialog box. See 
Appendix Regression Calculation Methods on page 111 to learn how each of 
these methods is calculated.

The data for volume standards is found in the Absolute Quantity column of the 
Volume Table. 

Note: Selecting the Force Through Origin checkbox always starts 
the standard curve graph at 0,0, regardless of the best curve fit.

ALIGNMENT

Align volumes by using the appropriate alignment button. To select several 
volumes, CTRL+click each one or drag them to use a selection box.

Copy and paste selected volumes by pressing CTRL+C to copy and then 
CTRL+V to paste. 

When you click Standard Curve in the toolbar, a chart displays all unknown 
and standard quantities.
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9 Generating Reports
After viewing results, you can generate a report that displays the analyzed gel 
images, all of the settings used in the protocol, and as much information 
about the data as you want to include.

The print report settings can be chosen with the Report Settings dialog box in 
the Edit menu or by clicking Report in the main toolbar. 

Report 
Click Report to produce a Print Preview of your report.

Clicking Print prints all of the above information to a printer. 
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Use the following dialog boxes to remove information from reports. Doing so 
does not delete the data from the analysis.

Display Report General Tab
The default setting is for all information to be included. These choices may 
have been made at other stages of the workflow, but you can customize 
reports here.

Clear any of the following checkboxes to exclude information from a report.

Custom Report Title—You can provide a custom report title for the report.

Include Gel Image—The following options determine which overlays display 
on the gel image.

• Show Lanes and Bands
• Show Volumes
• Show Annotations

Image Info
• Acquisition Information
• Analysis Settings
• Image Information
• Notes
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Report
Lane and Band Table Tab

Clear any of the following settings to exclude information from the report.

Include Lane and Band Table

Lanes to show: 
• All lanes or just user-defined lanes
• All lanes on one page, or one lane per page (add page break after 

each lane)

Show Lane Profile—includes the lane profile for each lane.

Move labels to the left—if you do not want these columns to be included in 
the report.
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Volume Table Tab

Include Volume Table—clear to exclude this information from your report.

Move volume labels to the left—to exclude their columns from the report.

Print Report 
Click Print Report to print a report. 

PRINT REPORT TO .PDF FILE 
Print Report to .pdf File brings up a Save dialog box so the .pdf file can be 
saved to your system.

ADJUST THE PRINTER SETTINGS 
Printer Settings accesses options for paper size, orientation, and page 
margins.
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10 Exporting Results
The most convenient way to archive complete information about experiments 
is to produce reports. However, you may want to export only gel images or 

analysis table data for analysis in different programs such as Quantity One, 
FPQuest™, or InfoQuest™FP software. Or you may need exported files for 
presentation or publication. 

Exporting Gel Images
Image Lab™ software includes features for exporting gel images several 
ways. 

• You can export displayed image data to a publication (choose 
Export for Publication) 

• You can export raw image data as a 16-bit TIFF file (choose Export 
for Analysis) 

• You can export image data to PulseNet; doing so reduces the 
image to an 8-bit TIFF file, limits its resolution, and restricts its file 
size to 300 Kb

• You can export lane and band tables as well as volume tables to a 
spreadsheet program or to a file 

The options to export gel images are available using the Export option in the 
File Menu.

The available export options are described in the following sections.
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EXPORTING GEL IMAGES FOR PUBLICATION

Use this format only to export visual information to presentation or word 
processing software, such as PowerPoint or Word.

When you select File > Export > Export for Publication, you can export a 
displayed image to a file. You can select from .bmp, .png, .jpg, and TIFF 
formats. The gel displays with any lanes, bands, and annotations that appear 
on the screen.

Note that you can select the entire image or the current view, select the 
resolution or specify a custom resolution, specify the publishing dimensions, 
and view the resulting published image size and dimensions. 
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You can zoom in on an area in a current view to export only that area or you 
can export the entire image. You can exclude annotations or overlays by 
clicking Display Gel Options in the toolbar to access the appropriate settings.

EXPORTING GEL IMAGES FOR ANALYSIS

When you select File > Export > Export for Analysis, you can export full image 
data (raw data only) for analysis as a 16-bit TIFF file. 

Note: 16-bit TIFF images are not compatible with all image 
viewers.

The image may require contrast adjustment when it is imported into analysis 
software. This option creates a file that can be analyzed in other programs 
such as Quantity One, FPQuest, or InfoQuestFP software. 

EXPORTING GEL IMAGES TO PULSENET INTERNATIONAL

When you select File > Export > Export for PulseNet, Image Lab software 
reduces the image to an 8-bit TIFF image file. Resolution is limited and file size 
is restricted to 300 Kb. 

Exporting Lane and Band Tables to Excel
If you have Excel (or Numbers, on a Macintosh) installed on your computer, 
choosing File > Export > Lane and Band Table to Excel opens a table directly 
in Excel. You can then use the Save As option to produce other formats.
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Exporting Volume Tables to File
Choosing Export > Volume Table to File exports as a CSV (comma-separated 
values) file so the data file can be opened in a database application. 

Screenshot Tool Export 
Use the Screenshot tool, available in the toolbar, to capture a displayed image 
to the clipboard or to save it to a file (.bmp, .gif, or .png). 

Analysis Table Export
You can export table analysis data from the File menu or by using the export 
buttons at the top of the Analysis Table window. 

The Analysis Table window has several buttons to export data to different 
formats, depending on how the data are to be presented.

COPY ANALYSIS TABLE TO THE CLIPBOARD 
Click this button to copy the analysis table to the clipboard and to paste the 
analysis table into word processing or presentation applications. It is best to 
use the vertical table orientation when copying to an 8-1/2 x 11-inch page to 
accommodate the columns.

EXPORTING ANALYSIS TABLE TO A FILE 
This button exports an analysis table as a CSV (comma-separated values) file, 
so your data file can be opened in a database application.

EXPORT ANALYSIS TABLE TO A SPREADSHEET 
This button enables you to use Excel’s sort and formula functions with your 
data. If you have Excel (or Numbers, on a Macintosh) installed on your 
computer, the data open in Excel.
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11 Maintenance
This chapterincludes instructions for maintaining the universal hood in proper 
working condition by replacing parts.

UV Transilluminator Lamp and Starter 
Replacement

Note: The UV filter surface should always be kept clean from the 
chemical agents used as gel dyes. Use protective gloves when 
touching the UV transilluminator cover. 

Depending on usage, the UV bulbs and starters last for many years. Replace 
bulbs when you notice them flickering. If a bulb does not turn on when it is 
new or moved, replace the bulb starter and test the bulb again.

There are three types of bulbs available. The catalog numbers are listed in 
Ordering Information on page 95. The standard bulb is 302 nm. Optionally, the 
254 nm bulb is used for cross-linking of proteins and nucleic acids, and the 
365 nm bulb is used to minimize denaturing of DNA.

To replace the lamps:
1. Turn off the power.

2. Disconnect the power cord from the universal hood.

3. Remove the four screws located on the left/right sides of the 
transilluminator cover.

4. Remove the cover with the UV glass by sliding it forward, then lifting up.
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5. Place it on a nonabrasive surface so that the glass does not get 
scratched or damaged.

Note: Do not put the UV cover directly on the bench. Wear gloves 
when touching the lamps.

6. Rotate the lamp until it becomes loose and the pins come to a vertical 
position.

7. Remove the lamp. Install the new lamp by rotating so that the pins are 
horizontal and the lamp is tight. 

8. Refer to the pictures above to replace a starter. Remove the starter by 
rotating the starter counterclockwise and then pull it out.

9. To replace a starter, insert it into the holder and rotate clockwise.

10. .Reassemble the cover and retighten the screws on both sides.

Epi-Illumination Lamp Replacement
The lamps are located behind two cover panels on the left and right sides of 
the universal hood’s interior.
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To replace the lamps:
1. Turn system power off and remove the power cord.

2. Open the enclosure door.

3. Locate the epi-white light housing inside the hood and the screw on the 
center of the cover.

4. Use a socket wrench to remove the screw, and the plastic cover that it 
holds in place.

5. Pull the cover to remove it from the housing, and the lamp will become 
visible.

6. To remove the lamp, hold it at the plastic receptacle and then pull it 
from the receptacle.

7. Insert the new lamp into the lamp receptacle and then push it into the 
receptacle.

8. Reassemble the epi-white light cover.

Fuse Replacement
Always unplug the instrument before changing or checking the fuses.

 

This unit is protected by 2 fuses (5 x 20 mm, 2A Slo-Blo). The fuses are 
located in the left side rear of the universal hood, in a fuse holder housed in 
the power entry module. See picture above.

To replace the fuses:
1. Unplug the main power cable from the power outlet.

2. Use a screwdriver as a lever on the fuse holder to extract the fuse.

3. Remove the blown fuses and replace them with two new ones (catalog 
#900-8935).

4. Slide the fuse holder into the power entry module until it snaps in place.

Power outlet Fuse holder
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A Troubleshooting
Follow these suggestions to troubleshoot your Gel Doc™ XR+ or ChemiDoc™ 
XRS system.

Problem Possible Cause Solution

Gel Doc XR+ and ChemiDoc XRS+ Systems

Camera does not 
respond/camera not 
found

• Camera power may be 
turned off

• Camera cables may not be 
seated properly

• Software driver for the 
camera is missing 

• Computer power-saving 
modes may be interfering 
with the camera driver

• Cables may be defective
• Camera may be defective

• Turn on the power to the camera 

• Make sure that all cables are connected 
as shown in the Installation Guide

• If camera driver is not present, reload 
the camera driver from the  
Image Lab™ software CD

• Disable power-saving modes on the 
computer 

• Replace cables
• Replace camera

Horizontal stripes in 
image when using the 
UV mode

• Emission filter not in proper 
position

• Move filter lever so that the filter slider 
positions the filter under the camera 
lens

Image is not visible on 
the monitor

• Incorrect monitor settings
• Lens cap attached

• See your computer manual for settings
• Remove lens cap

Image is not bright 
enough

• Wrong emission filter in use
• For chemiluminescent, 

emission filter is in front of 
lens

• Verify correct filter for application
• Verify no emission filter is in front of lens
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Printout does not look 
like the monitor image

• Monitor settings are wrong 

• Printer settings are wrong

• Refer to monitor instructions to correct 
settings

• Refer to the printer manual to correct 
settings

Light leakage into the 
darkroom

• The lens body is not seated 
properly against the gasket 
on the hood’s adapter plate

• Loosen the thumbscrew and seat the 
lens properly against the gasket on the 
hood’s adapter plate

Unable to focus on the 
sample using white 
light transilluminator or 
conversion screen

• Focus is not calibrated for 
samples using this light 
source

• Select Edit > Instrument Setup to 
recalibrate focus using the proper 
accessory

Lens limits seem 
artificially restricted

• Camera lens not seated 
properly on lens mounting 
plate

• Reseat camera on lens mounting plate

Gel Doc XR+ System Only

Hot (very bright) pixels 
are seen in the image 

• Corrupted dark image 
correction

• In Edit > Instrument Setup, recalibrate 
the dark image correction file

ChemiDoc XRS+ System Only
Images are grainy • Low signal-to-noise • For chemiluminescent applications, 

make sure no filter is used
• For applications other than 

chemiluminescent, make sure the filter 
is in line with the lens

• Use sample that generates more signal
• Use longer exposure times

Problem Possible Cause Solution
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Appendix B Accessories

Calibrating Accessories
If you are installing accessories along with your original system installation, 
you calibrate your system with a one-time Instrument Calibration wizard. 
Complete instructions are in the Installation Guide which arrives with your 
system, either 10016995 for the Gel Doc™ XR+ system or 10016999 for the 
ChemiDoc™ XRS+ system. If you acquire new conversion screens, light 
sources, or filters for a Gel Doc XR+ or ChemiDoc XRS+ imaging system after 
your original system installation, you will have to recalibrate your system to 
use them. 

Refer to Chapter 4 for instructions on how to calibrate newly-acquired 
accessories.

Installing Optional Accessories

UV/White Light Conversion Screen
This optional white light conversion screen converts the UV light generated in 
the universal hood to white light. Your system must be calibrated to use the 
white light conversion screen.
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To calibrate the system:
• Go to the Edit > Instrument Setup dialog box and select the 

appropriate checkbox. Image Lab™ software guides you through 
the calibration

To use the white light conversion screen:
1. Center the conversion screen on the imager stage.

2. Center your samples on top of the conversion screen.

3. Image the gel using your preferred application.

XcitaBlue™ Conversion Screen
The optional XcitaBlue conversion screen kit (catalog #170-8182) converts UV 
to blue light, which allows you to visualize DNA samples while protecting 
against UV damage. 

 

The XcitaBlue conversion screen is held in place by adhesive-backed edge 
guides. After installing the edge guides, the conversion screen remains 
centered and will not slide, even if you close the drawer rapidly.
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To install the XcitaBlue conversion screen:

1. Perform a trial placement first, without removing the paper tape. Place 
the edge guides in each corner of your transilluminator. The edge 
guides should touch the inside of the drawer front and fit over the edge 
of the metal transilluminator border (shown in red). 

2. Remove the paper tape from the bottom surface of each edge guide.

3. Press each edge guide into position carefully, as it is difficult to 
reposition them once the adhesive surfaces touch. 

4. Calibrate your system to use this accessory, by going to Edit > 
Instrument Setup. Select the XcitaBlue Conversion Screen checkbox 
under Illumination Options. The software prompts you to calibrate the 
focus with height offset.

5. When you need to visualize a sample using the XcitaBlue conversion 
screen, place the screen between the edge guides.

6. Center the gel on top of the XcitaBlue conversion screen, and proceed 
with normal image capture. See the Gel Alignment Template Kit for help 
centering your gels easily and consistently.

Adhesive-backed
edge guide

Transilluminator
drawer front

Transilluminator
border edge
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Gel Alignment Template Kit
The Bio-Rad gel alignment template kit (catalog #170-8184) allows four sizes 
of standard agarose gels to be centered quickly and easily, as well as ensuring 
the consistent placement of each gel. 

The kit contains:
• Magnetic locator frame
• Instruction sheet
• Alignment guides for the following gel trays:

Sub-Cell® GT UV-transparent mini-gel tray, 7 x 7 cm

Sub-Cell GT UV-transparent wide mini-gel tray, 15 x 7 cm

Sub-Cell GT UV-transparent mini-gel tray, 7 x 10 cm 

Sub-Cell GT UV-transparent gel tray, 15 x 10 cm

The gel alignment templates can be used with the XcitaBlue conversion 
screen kit (catalog #170-8182). The templates fit exactly into the XcitaBlue 
conversion screen frame.

To install and use the gel alignment template kit:
1. Place the locator frame over the transilluminator, with the magnetic side 

down. Match the corners of the magnetic locator frame with the edges 
of the transilluminator. The UV symbol on the frame will be in the same 
orientation as the UV symbol on the imager.

2. Place the gel alignment template that matches the size of your sample 
tray or agarose gel into the magnetic locator frame.

7 x 7 cm 15 x 7 cm 7 x 10 cm

Magnetic
locator
frame

15 x 10 cm
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3. Place your gel or gel tray into the open area of the template.
Note: No recalibration is necessary to use the gel alignment 
template kit.

White Light Transilluminator
The white light transilluminator provides a white light that is independent of 
the UV bulbs. Between uses, this transilluminator can be stored in the rear of 
the universal hood.

To install the white light transilluminator:
1. Open the enclosure door and pull the drawer toward you.

2. Locate the power cable positioned on the inside left side of the 
enclosure, behind the drawer slide.

3. Remove the black rubber boot that covers the connector plug and 
insert it into the white light transilluminator. Make sure that the main 
power switch on the transilluminator is in the ON position. 
Note: Power to the white light transilluminator is controlled from 
either the software or the membrane touch pad on the universal 
hood.

4. Place the white light transilluminator on top of the UV transilluminator. 
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Your system must be calibrated to use the white light transilluminator.

To calibrate, go to the Edit > Instrument Setup dialog box and select the 
appropriate checkbox. The Image Lab software will guide you through the 
calibration.

Orange Fluorescence Reference Plate
The 0range fluorescence reference plate allows you to apply UV flat fielding 
corrections to your Gel Doc XR+ and ChemiDoc XRS+ imagers. Corrections 
are made for all UV illumination sources, filters, and the camera lens. 

The 0range fluorescence reference plate can be used to correct for image 
non-uniformities for red and orange gels, including:

• Ethidium bromide
• GelRed
• Flamingo stain
• Coomassie Fluor Orange
• SYPRO Ruby
• Krypton
• Qdot 625

The orange fluorescence reference plate (catalog #170-8008) can be used 
with several Bio-Rad Molecular Imager® systems, including:

• Gel Doc XR+ system with Image Lab software
• ChemiDoc XRS+system with Image Lab software
• ChemiDoc XRS+ system with Quantity One™ software

When you order the reference plate you receive:
• Orange fluorescence reference plate, overall dimensions 29.5 x 

29.5 cm; viewing surface, 27 x 27 cm
• Instruction sheet (10017296)
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CALIBRATING YOUR SYSTEM TO USE THE ORANGE 
FLUORESCENCE REFERENCE PLATE 
Your system must be calibrated to use the orange fluorescence reference 
plate.

To calibrate the system:
• Go to the Edit > Instrument Setup dialog box and select the 

appropriate checkbox. Image Lab software guides you through the 
calibration

Ordering Information
The following table contains catalog numbers and descriptions for all parts 
available for the Gel Doc XR+ or ChemiDoc XRS+ systems, plus all optional 
accessories and replacement parts. For complete information, see the Bio-
Rad catalog.

Catalog # Description

Molecular Imager System (includes universal hood, camera, cables, and accessories)

170-8195 Gel Doc XR+ with Image Lab system for PC/Mac

170-8265 ChemiDoc XRS+ with Image Lab system for PC/Mac 

Installation Kits

170-8199 Gel Doc XR+ installation kit

170-8299 ChemiDoc XRS+ installation kit

Universal Hood

170-8180 Universal hood 

Imaging Cameras

170-8181 Gel Doc XR+ camera with motorized zoom lens

170-8255 ChemiDoc XRS+ camera with motorized zoom lens

Image Lab Software

170-9690 Image Lab software, Windows/Mac

Optional Filters

170-8074 Filter, 520DF30, GFP

170-8075 Filter, 560DF50, Cy3/Rhodamine 

170-8076 Filter, 630BP30, SYPRO Ruby 

Optional Accessories

170-8001 UV/White light conversion screen (UV to white light)
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170-7950 White light transilluminator (Universal hood plug-in)

170-8182 XcitaBlue (UV to blue light) conversion screen kit, without standard detection filter

170-8183 XcitaBlue (UV to blue light) conversion screen kit, with standard detection filter

170-8008 Orange fluorescence reference plate 

170-8089 Mitsubishi thermal printer, 100/240 V, USB

170-3759 Bio-Rad fluorescent ruler

170-3760 Gel cutter ruler

170-8184 Gel alignment template kit 

Replacement Parts

170-8026 Focus calibration target

170-8027 Image Lab flat fielding disc

170-8185 XcitaBlue viewing goggles

170-7581 Mitsubishi thermal printer paper, 4 rolls

170-7813 Sample holders for gels

100-2784 UV transilluminator lid (includes UV filter glass)

1001-4106 Thumbscrew for camera

170-8081 Standard emission filter replacement, 62 mm

100-1370 UV bulb starter, quantity 3

930-2242 Multicolor target

Lamps

100-2827 Lamp, epi-illumination, 5 W

170-8097 302 nm lamp kit, (6 lamps)

170-8098 254 nm lamp kit, (6 lamps)

170-6887 365 nm lamp kit, (6 lamps)

Fuses

900-8935 Fuse T 2 A, 250 V, quantity 10

900-0234 Fuse T 4 A, 250 V, quantity 10

Universal Hood

100-2785 Universal hood right shield epi-illumination (lid complete)

100-1948 Universal hood opal filter epi-white illumination (without metal frame)

100-2786 Universal hood left shield epi-white illumination (lid complete)

100-2787 Universal hood feet, 4

170-8068 UV shield for Universal hood 

Catalog # Description
104



Ordering Information
Connection Cables

931-0071 Cable, USB, Type A to B, 10 ft

901-0064 Cable, USB, Type A to B, 6 ft

Optional Analysis Software

170-9600 Quantity One software

170-9300 FPQuest™ software

170-9310 InfoQuest™FP software

Protein Standards

161-0363 Precision Plus Protein™ Unstained Standards

161-0373 Precision Plus Protein™ All Blue Standards

161-0374 Precision Plus Protein™ Dual Color Standards

161-0375 Precision Plus Protein™ Kaleidoscope™ Standards

161-0385 Precision Plus Protein™ WesternC™ pack

161-0318 Prestained SDS-PAGE standards, broad range

161-0317 Unstained SDS-PAGE standards, broad range

Nucleic Acid Standards 

170-8351 EZ Load™ 20 base pairs molecular ruler

170-8352 EZ Load 100 base pairs molecular ruler

170-8353 EZ Load 100 base pairs PCR molecular ruler

170-8354 EZ Load 500 base pairs molecular ruler

170-8355 EZ Load 1 kb molecular ruler

170-8205 2.5 kb molecular ruler

170-8200 AmpliSize® molecular ruler

170-8356 EZ Load precision molecular mass ruler (base pairs/ng of sample)

Pulsed Field Standards and Markers

170-3624 CHEF DNA size standard, 5 kb ladder

170-3707 CHEF DNA size standard, 8-48 kb

170-3635 CHEF DNA size standard, lambda ladder

170-3605 CHEF DNA size marker, 0.2-2.2 Mb

170-3667 CHEF DNA size marker, 1-3.1 Mb

170-3633 CHEF DNA size marker, 3.5-5.7 Mb

Catalog # Description
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Gel Doc XR+ and ChemiDoc XRS+ Systems
Appendix C Mitsubishi P93/
P95 Thermal Printer 
Settings

Windows
The printer driver can be found on the Image Lab™ software installation CD in 
the Misc directory. 

To set up a thermal printer on a Windows system:
1. Install the printer driver. 

2. Open the printer section in Control Panel.

3. Click the thermal printer icon and select Printing Preferences.
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4. Configure the correct paper size: select 1280 x 1280.

5. Select OK to apply your changes.

Macintosh
The printer driver can be found on the Image Lab software installation CD in 
the Misc directory. 

To set up a thermal printer on a Macintosh system:
1. Install the printer driver.

2. Connect the printer to the computer.

To configure the correct paper size:
1. Start Image Lab software.

2. Select FIle > Page Setup.
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3. In the Settings drop-down list, select Page Attributes.

4. In the Format For drop-down list, select the Mitsubishi printer.

5. In the Paper Size drop-down list, select 1280 x 1280.

6. In the Settings drop-down list, select Save as Default. 

7. Click OK to save the settings.
109



Gel Doc XR+ and ChemiDoc XRS+ Systems | Mitsubishi P93/P95 Thermal Printer 
110



Appendix C: Regression Calculation Methods
Appendix D Regression 
Calculation Methods
Each regression method calculates a standard curve. Some of the methods 
provide the formula for the standard curve. In this case, the molecular weight 
can be calculated by:

x = relative front of the band of interest

y = molecular weight of the band of interest 
 
Linear (semilog): The linear equation is y = a + bx, where a is the intercept 
and b is the slope of the line. 

NOTE: The linear equation is calculated on the log of the 
molecular weight values.

The R2 value may be used to determine the overall quality of the linear fit. A 

linear regression with an R2 value of >0.99 is considered a very good fit. The 
primary advantage of this method is that it is extremely simple. The primary 
disadvantage is that it will deliver incorrect results if the data are not very 
linear.

Point-to-point (semilog): No single equation is available for the point-to-
point method. The slope of each segment of the curve between data points is 
calculated independently.

NOTE: The log of the molecular weight values is used to calculate 
the slope for each segment of the curve.
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Logistic: The Logistic-4PL equation is

where:

x = mobility

y = molecular weight

a = estimated molecular weight at infinity

b = slope of the tangent at midpoint

c = midpoint

d = estimated molecular weight at zero mobility

Since the curve generated by the logistic-4PL regression method represents a 
perfectly shaped S, it might not fit the data very well in all cases.

Cubic spline: Cubic spline curves are smooth curves that go through every 
data point. The model is a cubic polynomial on each interval between data 
points. In some cases, a spline curve can work well as a standard curve for 
interpolation. However, because the curve is calculated individually for every 
pair of points, it does not correspond to any single equation.
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Glossary

CCD: (Charge-coupled device) A light-sensitive silicon chip used as a 
photodetector in Gel Doc™ XR+ and ChemiDoc™ XRS+ camera systems. 

Colormaps:  Different color representations of a gel image.

Electrophoresis: A technique for separating molecules based on the 
differential movement of charged particles through a matrix when subjected to 
an electric field.

Example precision: The number of decimal places chosen for 
displaying a measurement.

Flat fielding: An average intensity computation which compensates for 
non-uniformities generated by an instrument.

Histogram: A graphed representation of the brightness, or gray value, of 
an image. 

Native charge density: The inherent electrical charge of a protein 
without the addition of SDS.

pl: Isoelectric point; the pH at which a protein molecule carries no net 
charge.

Rf:  Relative front value of the band. In Image Lab™ software, Rf has a 
value between 0–1, and indicates the relative movement of the band from top 
to bottom.
113



Gel Doc XR+ and ChemiDoc XRS+ Systems | Glossary
Quantitative imaging: Determines the quantity of a sample’s 
components (nucleic acids and proteins), through analysis of the pixel values 
in a digital image of the sample.

UV-B: The range of ultraviolet light used by the system.

UV transilluminator: The part of the imager that transmits UV light 
through a sample.
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defined 112

Cubic spline regression method 74
Custom application 32

creating 32

D
Detect lanes and bands 36
Display gel options 48

E
Editing a protocol 42
Electrophoresis

defined 113
Emission filters 3
Epi-Illumination Lamp Replacement
92
Exporting

analysis tables 90
lane and band tables 89
results 87
volume tables 90

Exporting gel images 87
for publication 88
image files for analysis 89
to PulseNet International 89

F
File

image 19
Fit in Window

resizing Results files 49
Flat Fielding

defined 113
Fuse Replacement 93

G
Gel

nucleic acid 45
positioning 43

Gel Doc XR+
product description 1

Gel Doc XR+ Applications 8
Gel Doc XR+ Imager Workflow 7
Gel image

adding annotations 76
adjusting brightness and contrast

50
exporting 87
histogram 27

Gel image, adjusting irregular 67
Gel imaging 31
Gels

protein 45
Global background subtraction 80

H
Histogram 51

I
Image

file type 19
resizing 49

Image colors
changing colormaps 51

Image contrast
setting 50

Image information
viewing 53

Image Lab 2.0 Software 3
Image tools 64
Image Transform

set image contrast 50
116



 

L
Lane

background subtraction 67
detecting 66

Lane and band tools 66
Lanes and bands

detecting 36
Linear regression method 74
Local background subtraction 80

M
Maintenance 91
Merging blot images 64, 65
Molecular weight

analyzing 36
Molecular weight analysis tools 70

standard 70

N
Nucleic acid gels 45

O
Optional Accessories

installing 97
Optional conversion screen 4
Optional Printer 4
Ordering Information 103

P
Point-to-Point regression method 74
Positioning a gel 43
Printing reports 86
Protein gels 45

Protocol
creating 31
editing 42
opening saved protocol 41
running 43

Q
Quantity tools 71

R
Regression methods

cubic spline 74
linear 74
point-to-point 74

Relative quantity 71
Relative volume 81
Relative volume quantity 81
Report 83

adjusting printer settings 86
generating 83
printing 86
printing to .pdf file 86
specifying content 40

Resizing images 49
Results

exporting 87
Results file

resizing 49
viewing as 3D projection 52
viewing as lane profile 57
viewing image information 53

Rolling disk 67
Running a protocol 43
117



S
Screenshot tool 21, 90
Serial number, instrument 26
Setting image contrast 50
Signal accumulation mode 34
Snapshot tool 26
Specify content of reports 40
System Calibration 15

T
Technical Specifications

ChemiDoc XRS+ 13
Gel Doc XR+ 9

Three-dimensional projection 52
Troubleshooting 95

ChemiDoc XRS+ only 96
Gel Doc XR+ only 96

U
Universal Hood

product description 3
UV Starter replacement 91
UV Transilluminator replacement 91

V
venience 4
Volume

absolute 81
background subtraction 80
relative 81
tools 78
types 79



W
White Light conversion screen

description 4
White Light Transilluminator 4

X
XcitaBlue Conversion Screen 4

Z
Zoom tools

resizing images 49
119



Life Science
Group

    0711    Sig 021110017218 Rev D

Bio-Rad 
Laboratories, Inc.

Web site www.bio-rad.com  USA 800 424 6723  Australia 61 2 9914 2800  Austria 01 877 89 01  
Belgium 09 385 55 11 Brazil 55 31 3689 6600  Canada 905 364 3435  China 86 21 6169 8500  
Czech Republic 420 241 430 532  Denmark 44 52 10 00  Finland 09 804 22 00  France 01 47 95 69 65  
Germany 089 31 884 0  Greece 30 210 777 4396  Hong Kong 852 2789 3300  Hungary 36 1 459 6100  
India 91 124 4029300  Israel 03 963 6050  Italy 39 02 216091  Japan 03 6361 7000  Korea 82 2 3473 4460  
Malaysia 60 3 2117 5260  Mexico 52 555 488 7670  The Netherlands 0318 540666  
New Zealand 64 9 415 2280  Norway 23 38 41 30  Poland 48 22 331 99 99  Portugal 351 21 472 7700  
Russia 7 495 721 14 04  Singapore 65 6415 3170  South Africa 27 861 246 723  Spain 34 91 590 5200  
Sweden 08 555 12700  Switzerland 061 717 95 55  Taiwan 886 2 2578 7189  Thailand 66 2 6518311  
United Kingdom 020 8328 2000


	Gel Doc™ XR+ and ChemiDoc™ XRS+ Systems with Image Lab™ Software Instruction Manual
	Safety and Regulatory Compliance
	Table of Contents
	1 Introduction
	Gel Doc XR+ Imaging System
	ChemiDoc XRS+ Imaging System
	System Components
	Optional Accessories
	System Requirements
	Computer Specifications

	2 Gel Doc™ XR+ Imager
	Gel Doc XR+ Imager Workflow
	Gel Doc XR+ Applications
	Gel Doc XR+ Technical Specifications

	3 ChemiDoc™ XRS+ Imager
	ChemiDoc XRS+ Imager Workflow
	ChemiDoc XRS+ Applications
	ChemiDoc XRS+ Technical Specifications

	4 System Calibration
	5 Image Lab™ Software Overview
	Interface Overview

	6 Acquiring Images
	The Protocol Setup Window
	Creating a Protocol
	Choosing a Protocol
	Positioning the Gel
	Running a Protocol
	Application Tables

	7 Viewing Images
	Results Overview
	Displaying Gel Images
	Displaying Data

	8 Analyzing Images
	Auto Analysis Settings
	Analysis Toolbox Tools

	9 Generating Reports
	Report

	10 Exporting Results
	Exporting Gel Images

	11 Maintenance
	UV Transilluminator Lamp and Starter Replacement
	Epi-Illumination Lamp Replacement
	Fuse Replacement

	Appendix A Troubleshooting
	Appendix B Accessories
	Calibrating Accessories
	Installing Optional Accessories
	Ordering Information

	Appendix C Mitsubishi P93/ P95 Thermal Printer Settings
	Appendix D Regression Calculation Methods
	Glossary
	Index

